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Preface

How this guide is organized

This guide is organized by task, rather than by command. For example,

when you want to move a file, refer to Chapter 5, “Managing directories and

files,” rather than a chapter that describes the Move command.

To find information about a specific command, task, or subject, refer to the

index. We have included as many synonyms as possible for each subject and

task.

Looking Glass Professional features

Features that are only available in Looking Glass Professional appear in the

shaded portions of the page. If you are a Looking Glass user, these features

will not be available unless you upgrade to Looking Glass Professional.

Use of terminology in this guide

Throughout this guide, we have tried to avoid the use of technical terms.

When it is necessary to use a term, we italicize it the first time it is used. For

about general computer terms or concepts introduced in this

system documentation or a general glossary of computer
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Style conventions

Most of this guide is devoted to step-by-step instructions for per-

forming tasks.

Procedure styles

The following style conventions are followed in all procedures.

The steps of a procedure are printed in boldface.

For example:

1. Choose Open from the File menu in the Directory

window.

The names of buttons and check boxes are capitalized as they are

on your screen.

For example:

1. Click the Maximize button.

To perform certain actions, it is necessary to hold down one key

while typing another.

For example:

Control+N

The number of the last (or only) step in each procedure is printed

in outlined type.

For example:

1.Choose Quit Looking Glass from the System menu

in the Global window.

or

1. If the files and directories you want displayed

first are not already selected, select them.

2.Choose Group Selected Objects from the Sort menu

in the Directory window.

The names of files, directories, programs, and arguments to pro-

grams are printed in Courier font.
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For example:

The FSS maintains a small database file (.1gdb) in each direc-

tory with information needed to display, print, edit, and acti-

vate each file.

Text that you should type is printed in boldface Courier font.

For example: |

If all of your text files are encrypted, you may want to use the

editor vi with the -x argument for editing encrypted files.

In this case you would type:

/usr/bin/vi -x #f

Command language syntax styles

Generalized

syntax diagram

The following style conventions are used in command and lan-

guage syntax descriptions. Most of these apply only to the informa-

tion in Chapter 13, “Defining file types.” Most Looking Glass users

won't need to perform the tasks that require use of command and

language syntax descriptions.

Syntax diagrams and source code samples are printed in Courier

type.

In generalized syntax diagrams, sections for which detailed syntax

is not presented are represented by descriptive labels enclosed in

“less than” (<) and “greater than” (>) symbols.

For example:

DEFINE TYPE <type name>

ICON <icon name>

FILE DESCRIPTION <text>

<rule statement>

<command section>

END

Fixed elements of the command or language (including keywords,

mathematical symbols, and other non-alphabetic characters) are

printed in boldface in syntax diagrams. These elements are repre-

sented literally, with any required capitalization, both in the syntax

diagram and in accompanying text. When referenced in text that is

not part of a syntax diagram or table, these elements are printed in

the font used by the surrounding text and retain any upper and

lowercase characteristics indicated in the syntax diagram.
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Fixed elements

Variable element

Optional syntax

element

Exclusive list from

which user must

choose one

Optional element

Variable data supplied by the user is represented by italicized

descriptive labels. When referenced in text that is not part of a syn-

tax diagram or table, they are italicized and printed in the font used

by the surrounding text.

For example:

5 q

FILE DESCRIPTION "Description"
———

Optional syntax elements are enclosed in brackets (“[” and “]”).

Lists of items separated by vertical bars (|) are exclusive lists from

which the user may choose one and only one item. If the list is

enclosed in braces (“{” and “}”), one item must be used.

For example:

eeeereteereeeedieereeee

CONTENT Offset [TO Offset]

{STRING | BYTE | SHORT | TONG} [< 1 >] =]

{" String" | | NumericValue}

Ellipses (...) following a syntax element indicate that the element

can be repeated an unlimited number of times.

For example:

that can be repeated
———

DIRECTORY Name [Name ...]



Getting started in Looking Glass

In this chapter, you'll learn what Looking Glass is and how to start it:

e Automatically (as your login shell)

¢ Manually (from a command line)

You'll also learn how to quit Looking Glass.

After you have learned the basics of starting and quitting, we’ll give you a brief tour

of a typical Looking Glass workspace. You’ll become familiar with the Looking Glass

windows and icons that you'll use in your work.



1-2 he Looking Glass User’s Guide

What is Looking Glass?

Looking Glass is a graphical user environment for your workstation

or X Window System terminal. It gives you the ability to organize

your personal workspace so that the programs, files, and directories

you use most often are within easy reach.

With Looking Glass, you can run a program (like a spreadsheet or

word processor) by simply double-clicking on the program’s icon or

one of its data files. Moving a file between directories is just as easy:

you drag it from one window to another with the mouse. You can

even perform tasks such as creating links and changing file owner-

ship and access permissions without typing a single command.

Here are just a few of the many tasks that Looking Glass simplifies

for you:

e Running programs

e Opening files for editing

e Printing files

e Viewing the contents of directories

e Creating new directories

° Moving, copying, and removing files

¢ Viewing and changing information about directories and files

e Finding directories and files in your system

¢ Displaying and changing information about directories and files

In the following sections, we'll tell you how to start and quit

Looking Glass, give you a brief tour of a typical Looking Glass

workspace, and introduce you to Looking Glass icons.

Starting Looking Glass

There are two ways to start Looking Glass:

e Use it as your login shell

e Run it from a command line

Depending on your system, you or your system administrator may

have to start the License Server before you can start Looking Glass.

For information about the License Server, refer to the Looking Glass

Installation Guide.

Starting Looking Glass as your login shell

If Looking Glass is set up as your login shell, you can simply log in

to your system following your normal procedures. After you log in,
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Looking Glass starts up immediately, and you are ready to start

working.

If Looking Glass is not your login shell and you would like it to be,

see your system administrator.

If you are responsible for installing Looking Glass as a login shell

for yourself or other users, refer to the descriptions of the com-

mand-line arguments for Looking Glass in “Specifying Looking

Glass options at startup” later in this chapter.

Starting Looking Glass from a command line

You can run Looking Glass from your system’s command-line

prompt by executing the program 1g.

If you start Looking Glass from a command line, you should run

the program as a background process by placing the ampersand (&)

character at the end of the command. If you don’t run Looking

Glass in the background, the terminal window that you start

Looking Glass from will be busy until you quit Looking Glass.

1. Type:

1gs

2. Press Return.

The Looking Glass startup window appears, followed by the

Looking Glass windows.

If you need help the first time you run Looking Glass from a

command line or use any program options, contact your system

administrator.

Specifying Looking Glass options at startup

This section is intended for system administrators and other users

who are responsible for maintaining Looking Glass.

Looking Glass provides a set of startup options that allow you to

open specific directories at startup time and control certain aspects

of the program’s appearance and operation. If your users start

Looking Glass from a command line, they can do this easily at the

time they run Looking Glass. If your users start Looking Glass as

their login shell, you can specify these arguments for them.
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1. Click in the window of the command-line shell you

want to run Looking Glass from.

2. Enter:

lg <arguments> &

where <arguments> is the list of arguments you want to specify

(refer to the following table for the list of arguments you can use).

For example:

lg budget plans -display lotus:0.0 &

This example tells Looking Glass to:

e Start as a background process (indicated by the &)

e Open the directories budget and plans

e Use the machine “lotus” as its display

3. Press Return.

The following table describes the arguments you can specify at

startup:

This argument: Does this:

-help Tells Looking Glass to print a summary of command-

line arguments.

-version Tells Looking Glass to display version information

or without starting.

-ver

directories Opens the directories you specify at startup

automatically.

-pro Specifies Looking Glass Professional.

~std Specifies Looking Glass even if a Looking Glass key

is available.

-uwmstyle Tells Looking Glass to display windows compatible

or with the uwm window manager.
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This argument: Does this:

~frame Tells Looking Glass to put a frame around its

windows.

Use this argument for window managers that do

not supply frames for windows.

-bordercolor color

or

-color

Lets you specify a color for Looking Glass

window borders.

This argument only takes effect when the

-~frame argument is also used.

-borderwidth width

or

-bw

Lets you specify a width in pixels for

Looking Glass window borders.

This argument only takes effect when the

-frame argument is also used.

-lookandfeel style

or

Lets you specify a look-and-feel style.

-laf style Specify Motif for OSF/Motif, o1 for OPEN

LOOK, or 2d for Presentation Manager.

-font font Lets you specify a font for plain (nonbold)

or text.

-fn font

You can use any font available on your system.

-bold font Lets you specify a font for bold text.

or

-fb font You can use any font available on your system.

-mono Forces a monochrome display on a color

monitor.

~foreground color

or

-fg color

Lets you specify a color for the user interface

elements that are in the foreground.

Use a color from the system’s color database or

specify a color’s Red, Green, Blue (RGB) value in

hexadecimal notation.
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This argument: Does this:

-background color

or

~bg color

Lets you specify a color for the user interface

elements that are in the background.

Use a color from the system’s color database

or specify a color’s Red, Green, Blue (RGB)

value in hexadecimal notation.

-topshadow color

or

-ts color

Lets you specify a color for the top shadow

of the user interface elements.

Use a color from the system’s color database

or specify a color’s Red, Green, Blue (RGB)

value in hexadecimal notation.

-bottomshadow color

or

-bs color

Lets you specify a color for the bottom

shadow of the user interface elements.

Use a color from the system’s color database

or specify a color’s Red, Green, Blue (RGB)

value in hexadecimal notation.

-display machine Lets you specify the hardware display name

for the machine whose display will be used

by Looking Glass.

This option is only valid under the X Window

System. The machine name supplied will be

used to set the DISPLAY environment variable.

-~preload Tells Looking Glass to preload all icon images

at startup for faster display performance.

This is the default.

~nopreload Tells Looking Glass not to preload icon

images at startup.

Quitting Looking Glass

1. Choose Quit Looking Glass from the System menu in

the Global window.

If there are no programs running that you launched from

Looking Glass, Looking Glass quits.
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If there are programs running that you launched from Looking

Glass (for example, the Icon Editor or a terminal emulator win-

dow), a message box opens asking you if you want to quit

Looking Glass without quitting the programs you launched.

WROTE RPI
cpaauaas prema

One or more programs launched from within

Looking Glass are still running. Quit

anyway?

[ves] [Lm _]

To close this message box, click:

e Yes to quit Looking Glass and leave the other programs

running

e No to cancel and return to Looking Glass

NOTE:

Any Looking Glass windows you have open when Looking

Glass quits will open automatically in the same positions the

next time you start Looking Glass.

A brief tour of Looking Glass

In this section, we'll give you a brief tour of a typical Looking Glass

workspace. We call this a “typical” workspace because Looking

Glass gives you the ability to organize your workspace any way you

want, placing the programs, files, and directories you use most

often within easy reach. When you quit, Looking Glass remembers

how you left your workspace and restores that arrangement the

next time you start Looking Glass.

In addition, Looking Glass lets you name and save an unlimited

number of workspace layouts so you can switch easily from one lay-

out to another. For instructions on organizing your workspace and

saving layouts, refer to Chapter 9, “Organizing your workspace.”

The illustration on the following pages shows you a typical Looking

Glass workspace. We’ve labeled the windows so you can begin to

familiarize yourself with them. In this chapter we'll introduce the

major windows in Looking Glass.
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Global window

| : eae : pam r ae | Srelude-/usrMal!Personnel¥s
s File Create View Sort Select Run Color |

— a. 6 Ads

m” | © Benefits © Handbook © Litigation

Directory window B | & Reviews

in Name view |

Agencies @ Employee_info @ Hiring_Sched

Offer_Letter Recruit_Letter Salaries

Staffing_Plan

m File Create View Sort Select Run Color

a. rx r-x (x hal dsgrp 16 1024

Directory window in a. WX [f-xX f-x root system 25 512

Wide view © Archive rwx r-x rx hal dsgrp 2 512

© Budget rx r-x 0 f=x hal dsgrp 4 912

© Data wx ‘-x fx hal dsgrp 2 512

Acme_Letter rw- r-- f-- hal dsgrp 1 339

Ad_Copy nw- [-- f-- hal dsgrp 1 4827

Appointments mw- r-- [-- hal dsgrp 1 234

Q Client_List m- r-- -- hal dsgrp 1 18179

Forecast w- r-- f-- hal dsgrp 1 4648

Phone_List rw- r-- f-- hal dsgrp 1 3016

Sales_Leads rw- r-- f-- hal dsgrp 1 54397



Directory window in Icon view

mB File Create View Sort Select Run Color
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Desktop Panel

ER
Administrators

Exec_Summary

Archive

(7
Phone_List

Sales_Leads Forecast

Personnel

Database

By
spreadsheet

| Modification Time | ype | Link Content

09:56 Oct 26 1990 Directory

2 14:47 Nov 20 1990 Directory

34823 18:56 Jul 26 1390 Directory

73766 11:50 Oct 14 1990 Directory

88072 15:35 Oct 15 1990 Directory

71709 12:53 Mar 14 1990 Tet file

71703 11:32 Apr 28 1990 Tet file

71738 13:15 Oct 21990 Desktop calendar document

71730 11:37 Sep 25 1990 Card file

71705 13:38 Nov 20 1989 Spreadsheet data file

71707 12:48 Aug 5 1988 Card file

71731 = «12:58 Feb 28 1990 Database data file
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The Global window

The Global window is the only window in Looking Glass that

always appears on your screen when Looking Glass is active. All

other windows can be opened or closed at your command.

From the Global window, you can perform “global” tasks such as:

e Setting your preferences for how Looking Glass operates

¢ Opening other Looking Glass windows

e Maintaining environment variables

e Accessing the help system

e Running a terminal emulator

e Quitting Looking Glass

When you launch a program with Looking Glass, the application’s

icon is displayed in the Global window as long as its application is

active.
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Directory windows

Directory windows display the contents of a directory.

Here is a typical Directory window:

From Directory windows, you can perform tasks like:

e Opening and closing selected directories and files

e Launching programs

e Changing the way you view directories and files

e Printing files

e Moving and copying files

¢ Removing directories and files

You can view objects in a Directory window by their icon or name,

or in a wide format that contains detailed information. The exam-

ple above shows a Directory window with objects displayed as

icons. For more information about these display formats, refer to

“Changing display formats” in Chapter 4, “Working with Directory

windows.”

If you have a color display, you can also control the color of icons

in Directory windows. For more information about viewing directo-

ries and files in Directory windows, refer to “Changing display for-

mats” in Chapter 4, “Working with Directory windows.”
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Directory windows separate directories from files with a horizontal

bar called a splitter. The top section of a Directory window displays

the subdirectories in that directory and the bottom section displays

the files in that directory. You can move the splitter to adjust the

height of each section.

You also have the option of removing the splitter and positioning

directories and files anywhere in the Directory window. For informa-

tion about positioning directories and files, refer to “Repositioning

directories and files” in Chapter 4, “Working with Directory win-

dows.”

You can display as many Directory windows as you want, but you

can only display a particular directory in one window at a time.

The Desktop Panel

The Desktop Panel gives you a place to put frequently used pro-

grams, files, and directories. The objects you put on the panel are

not actually moved from their locations in the file system—they are

just displayed there for easy access. You can open or activate any

object from the Desktop Panel the same way you can in Directory

windows.

Here is a typical Desktop Panel:

| me ae Desktop Panel ms / : aaa
File View

se [fi
Phone_List News

Paint Database

Budget Personnel

Letters Proposals
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Notice that there are several directory and file icons in our sample

panel. Objects you put on the panel stay there until you take them

off. You'll probably find yourself keeping directories and files on

the panel on an “as needed” basis. For example, you might display

the directory Budget _90 during the week you are working on a bud-

get. On the other hand, if you use your spreadsheet application all

year round, you would probably keep it on the panel all the time.

Once you have placed an object on the Desktop Panel, you can put

it in any position you want. This allows you to put directories and

files in the most convenient order.

When you save a workspace layout, the size and position of the

Desktop Panel, as well as its contents, are also saved.

Looking Glass icons

Icons play an important role in your Looking Glass workspace.

Looking Glass icons are images that represent directories and files

in your system. There’s an easily recognized icon for each type of

directory or file in your system. As you can see from our “typical”

workspace, icons can appear in a number of locations.

Looking Glass provides an Icon Editor for managing icons. With

the Icon Editor, you can:

e View the Looking Glass icons in your system

e Edit existing icons

e Create new icons

If you browse through the icons that come with Looking Glass,

you'll notice that certain characteristics are represented in more

than one icon design. Icons with the same design make up an icon

“family.” Some of the more important icon families are described

on the following page.
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Icons with one fold in the upper right corner represent data files

that may be opened by more than one application. An example of

this type of file is a file that contains only text. This type of file can

be edited by more than one editor or word processor. Icons in this

family often contain another visual cue that indicates what applica-

tion created them or what kind of data is in them. Here are some

examples of icons used to represent data files:

Text file Empty Password
file file

Icons with two folds in the upper right corner are data files that

contain data in a format that is probably meaningful only to the

application that created them. Files in this family include the data

files that programs create to store your work. Here are some exam-

ples of icons used to represent data files containing data formatted

for a specific program:

Spreadsheet Word processor Database
document document data file

The folder icon represents a directory. Within this family, there are

different types of directories. For example, the picture of a house on

a folder represents your home directory. When a directory is open

somewhere on your workspace, its folder icon is “fanned” to make

it appear open. Here are some examples of icons used to represent

directories:

a #4 &
Home Open Mounted

directory directory directory

As you work with Looking Glass, you’ll notice other common char-

acteristics that make up icon families; you can even create some of

your own icons with the Icon Editor. For more information about

the Icon Editor, refer to Chapter 10, “Working with the Icon

Editor.”



How you interact with Looking Glass _ .

This chapter teaches you the basic skills for interacting with Looking Glass. It is

intended to help users who have not used icon- and mouse-driven programs such as

Looking Glass.

You’ll learn how to move around in Looking Glass using a mouse and keyboard to

activate commands and operate Looking Glass controls such as menus and buttons.

In this chapter, you'll also become familiar with the window frame elements and

learn how to use your window manager to:

¢ Move windows around on your workspace

e Change the size of windows

e Close windows~

The screen pictures and instructions in this user’s guide assume that you are using

Looking Glass with the OSF/Motif look-and-feel. However, Looking Glass can also be

run with the OPEN LOOK or Presentation Manager look-and-feel. Refer to the

description of the -laf argument in the section “Specifying Looking Glass options at

startup” in Chapter 1, “Getting started with Looking Glass” for instructions on speci-

fying a look-and-feel at startup time.

Although there are minor variations in the appearance and operation of some user
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Using the mouse and keyboard

This section explains how to use the mouse and keyboard to inter-

act with Looking Glass. The term mouse refers to any kind of point-

ing device used to control your workstation or X terminal.

Most Looking Glass actions require a mouse, but some actions can

be controlled using the keyboard. This section explains how to navi-

gate with a mouse first, then describes some keyboard shortcuts.

Using the mouse

Throughout this manual, you’ll be instructed to perform basic

mouse actions, such as clicking and dragging. The following para-

graphs explain these basic actions and tell you how to perform

them. Looking Glass does not distinguish between mouse buttons,

so when you are told to press a mouse button, you can press any of

them.

You'll perform four basic mouse actions in Looking Glass:

e Click

e Double-click

e Shift-click

e Drag

Clicking

Clicking the object that the pointer is on in a window selects that

object. Clicking in a text field moves the cursor to the place where

you clicked. If an object or word is already selected, clicking any-

where else in the window unselects the object or word.

1. Put the pointer on an object or in the new location in

the text.

2. Press and release a mouse button.

If you clicked an object, it is highlighted. If you clicked in a text

box, the insertion cursor moves to that spot.
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Double-clicking

Double-clicking the object that the pointer is on in a window acti-

vates or opens that object. You double-click a word in a text field to

select (highlight) that word.

1. Pat the pointer on an object or word.

2. Quickly press and release a mouse button twice.

If you double-clicked an object, it is activated. If you double-

clicked a word in a text field, it is highlighted. If you double-

clicked a an item in a list, the command associated with that

item is activated.

Shift-clicking

The shift-click action selects (or unselects) the object that the

pointer is on in a window without unselecting other selected

objects.

1. Put the pointer on the object you want to select.

2. Press the Shift key while you press and release a

mouse button.

If you shift-clicked an unselected object, it is selected. If you

shift-clicked a selected object, it is unselected. If you shift-

clicked a word, it is highlighted.

Dragging

Dragging allows you to select or move one or more objects from one

place to another in a window. You can also select a word or a block

of text in a text field by dragging.

Before you select a group of objects, you should imagine a rectangle

around the group of objects you want to select. You'll drag across

the group of objects by starting at one of the corners of this imagi-

nary rectangle.

Selecting a group of objects by dragging

1. Put the pointer in the window near the objects you

want to select, at the corner of the imaginary rectan-

gle surrounding the objects.
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2. Hold down a mouse button.

3. Move the pointer diagonally across the area contain-

ing the objects you want to select.

As you move the pointer, the objects are enclosed in a selection

rectangle.

Here is an example of a group of objects that have been

selected:

Archive Budget

qo
Data Letters Personnel Proposals

Acme_Letter Ad_Copy: &

A group of selected
objects

4, When all of the objects you want to select are enclosed

in the rectangle, release the mouse button.

The objects are highlighted.

Moving an object by dragging

1. Put the pointer on the object you want to move.

2. Hold down a mouse button.

3. Move the pointer to move the object to a new location.

4, When the object is where you want it, release the

mouse button.
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Selecting text in a text box by dragging

1. Put the pointer at the beginning or end of the text

you want to select.

2. Hold down a mouse button.

3. Move the pointer across the text you want to select.

4,, When you are finished highlighting the text, release

the mouse button.

Using accelerator keys

Looking Glass is intended to be controlled primarily with a mouse.

However, you can use the keyboard to perform certain tasks.

An accelerator key is a single key (such as F1) or a combination of

keys (such as Control+F1) that is assigned to a command in a menu.

Using an accelerator key has the same effect as selecting a com-

mand from the menu with the mouse.

Not all commands in Looking Glass can be selected with accelerator

keys, but many can. When a command can be selected with an

accelerator key, the key sequence is displayed next to the command

in the menu.

SRG retuce:visix/user malas Coaall ae

File} Qeate View Sort Select Run Color

Change Directory... ay

Retype Directory

Open menu ---- | ose wy

bifarmnation A

Prait ap

Open AQ

Remove

Capy...

Move...

Lark... AL

4] Gxanye Properties...

Put on Desklop Pail

ER
To_Do zycor_Letter
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The accelerator keys in Looking Glass are abbreviated in the menus.

For example, when you see “N in the Create menu, you press

Control+4N.

The following table lists the commands in Looking Glass that can

be selected with accelerator keys. To use any accelerator key, press

the key or combination of keys listed in the table.

Window Command Menu Accelerator key

Global Open Directory Windows Control+Y

window Terminal Emulator Run Control+T

Command Line Run Control+R

Directory Change Directory File Control+Y

window
Close File Control+W

Information File Control+! (or TAB)

Print File Control+P

Open File Control+O

Link File Control+L

Directory Create Control+N

icon View Control+K

Wide View Control+E

Group Selected Objects View Control+G

Clean Up View Control+U

Select By Pattern Select Control+S

Select All Files Select Control+A

Find Select Control+F

Terminal Emulator Run Control+T

Command Line Run Control+R
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Window Command Menu Accelerator key

Desktop Close File Control+W

Panel Open File Control+O
Show File Control+H

Print File Control+P

Icon View Control+K

Clean Up View Control+U

Tree View Open In Tree Directory Control+O

window
Close In Tree Directory Control+C

Show In Tree Directory Control+l

Open In Window Directory Control+yY

Close Tree View Directory Control+W

Name View Control+N

Icon View Control+K

All Directories Select Control+A

All Open Directories Select Control+P

All Unselected Select Control+U

Directories

Parent Directories Select Control+Q

Subdirectories Select Control+Z

Subtrees Select Control+B

Save Tree As Tree Control+S

Open Saved Tree Tree Control+T

Merge In Saved Tree Tree Control+M

Find Show Control+F

To use an accelerator key, hold down the Control Key and press the

appropriate letter key. You can also access the online help for

Looking Glass by pressing the F1 key.
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For information about the commands executed by these keystrokes,

refer to the sections in this manual that explain the task associated

with the command. For example, for information about the Link

command, refer to Chapter 5, “Managing directories and files.”

Using your window manager

A window manager is a special program that controls the appearance

and behavior of windows displayed by programs such as Looking

Glass. Because of the differences among window managers, you

may notice differences between the window frames on your screen

and the Looking Glass window frames shown in this manual. This

manual shows Looking Glass windows with the OSF/Motif window

manager, mwm.

If your window manager doesn't put frames around windows, you

can have Looking Glass put frames around windows by starting it

with the -frame option. For more information on Looking Glass

startup options, refer to “Specifying Looking Glass options at

startup” in Chapter 1, “Getting started with Looking Glass.” The

frame that Looking Glass provides works according to OSF/Motif

user interface guidelines.

NOTE:

Even though Looking Glass can provide frames if you need them, it

does not replace the need for an actual window manager.

Knowing how to use your window manager is important because it

allows you to move, resize, and close Looking Glass windows. This

section tells you how to perform some basic actions using the

frames that Looking Glass puts around its windows when using the

-frame option.
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The following illustration shows the portion of a typical Looking

Glass window that is displayed and controlled by the window man-

ager and the area that is controlled by Looking Glass:

Frame controlled by---.------ 3
window manager

Area inside frame ---:-----3-4 sev

controlled b
Looking Glass

To_Do Zycor_Letter

Notice in this example that the window manager controls the outer

portion of the window (the frame around the window). Everything

inside the window is controlled by Looking Glass.

Window frame elements

Looking Glass window frames contain these elements:

¢ Window Manager button

e Title bar

e Minimize and and Maximize buttons

e Resizable border

The following illustration shows you the locations of the window

frame elements:

Window Manager ........-%
menu button

Title bar tcc ec cece Mec rcweseee

Minimize button Bono ccccccccscscecsssscssssasessssssssessesssessessaesssssssssscaversuvsueresesesevsveseeve.

Maximize button ......--. Doo oce cece ee eeece cece ceeeecesebeseecececessese. oo a:

Window frame ---------
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You can access some of the window manager functions through the

Window Manager button. This button allows you to perform simple

tasks such as maximizing, lowering, and closing the window.

However, most of the actions in this menu can be performed more

quickly with the other elements of the window frame. These ele-

ments are described in the next section. A command is dimmed

(grayed out) when the option is not available.

The Window Manager button is located to the left of the title bar at

the top of the window frame.

Accessing the Window Manager menu

1. Click the Window Manager button.

The Window Manager menu opens.

Moving windows

One of the ways you'll find yourself manipulating windows is by

moving them around on your workspace.

The window manager provides an area called the title bar at the top

of each frame for the name of the window. The title bar also pro-

vides a fast way to move the window to another location.

Moving a window to another position

1. Move the pointer to the title bar in the window.

2. Drag the window to its new position.

3. When the window is where you want it, release the

mouse button.

Bringing a window to the front of a stack of windows

1. Click in the title bar on the window.

The window moves to the front of the stack.

NOTE:

Some window managers allow you to click anywhere in a win-

dow to bring it to the foreground.



Chapter 2: How you interact with Looking Glass hs. 2-11

Here is an example of stacked windows:

Database Offer_Letter Staffing_Pian

You can bring a Looking Glass Directory window to the front of a

stack of windows by using the Windows menu in the Global win-

dow (for more information, refer to Chapter 4, “Working with

Directory windows”). Using the Windows menu is helpful if you

have so many windows open on your workspace that the window

you want to bring to the front is completely hidden.

Moving a window behind a stack of windows

1. Choose Lower from the Window Manager menu.

The window moves to the back of the stack.

Resizing windows

In addition to letting you move a window to a new location on the

workspace, the window manager also lets you control the size of

the window. You can make most windows smaller or larger by

using the frame provided by your window manager.
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There are two ways to enlarge a window: stretching the frame in

increments, or using the Maximize button to blow up the frame.

Resizing a window using the frame

1. Move the pointer to a corner or edge of the window

frame. |

2. Drag the window frame up, down, left, or right to

resize it.

3. When the window is the size you want it, release the

mouse button.

Resizing a window using the Maximize button

1. Click the Maximize button.

The window is enlarged so that it fills your screen.

Restoring a maximized window to its original viewing size

1. Click the Maximize button again.

The window is restored to its original size and position on the

workspace.

NOTE:

You can only restore a window to its original size if you used

the Maximize button. If you used the frame to enlarge the win-

dow, clicking the Maximize button won’t restore it. You must

use the frame to make the window smaller.

Closing windows

Although you can close any window on your workspace by select-

ing a command from a Looking Glass menu, the window manager

also lets you close any window with a frame around it by using the

Window Manager button at the top of the frame.
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NOTE:

If you close a terminal emulator in which you have been running a

shell or application, you must exit the shell or quit the application

before you close the window. Using the window manager to close

the terminal emulator window won’t quit the shell or application.

1. Choose Close from the Window Manager menu.

The window closes.

Working in Looking Glass windows

Now that you know how to perform basic mouse and keyboard

actions and use your window manager, you are ready to work with

Looking Glass windows.

Window types

As you work in Looking Glass, you’ll use windows and dialogs. This

section describes windows and dialogs and shows you how to use

the controls that appear in them.

Using windows

A window is an area that stays open on your workspace unless you

explicitly close it. Windows can be controlled using your window

manager. Windows usually contain menus.

The most important windows in Looking Glass are:

e The Global window

e Directory windows

e The Desktop Panel

These three windows were introduced in Chapter 1, “Getting

started with Looking Glass.” You'll learn more about the specific

tasks you can perform using these windows as you continue

through this manual.
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Using dialogs

A dialog is a window that usually appears as a result of an action

you perform in another window and has a single purpose. Dialogs

are subordinate windows that prompt you for input, allow you to

confirm or cancel an operation, or present information. You must

complete the operation in some dialogs before you can proceed.

Here is an example of a dialog:

Copy Buffer Size:[f JK =e Size Limit: [2097151 |K

ble- Click Speed Directory Double- Glick Action

© Slow © Control-Double- Glick Opens New Window

@ Medium @ Double- Click Opens New Window

© Fast

Seconds Between Display Updates:

Set Operational Preferences | Cancel | [ OK |

A message box is a dialog that displays an announcement or warn-

ing. A message box may ask you to confirm or cancel an operation

when you try to perform a task that can’t be undone or warn you

when you try to perform an operation that you aren’t allowed to

perform.

When a message box appears, you must click OK before you can

continue.

Pull-down menus

A pull-down menu is a list of commands located in the menu bar of

some Looking Glass windows. The titles of the pull-down menus

appear in the menu bars.
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Here is an example of a pull-down menu:

Menu title -------- ie dows

About Looking Glass

Color Preferences...

Removal Preferences...

Execution Preferences...

Creation Preferences...

Cleanup Preferences...

Display Preferences...

Operational Preferences...

Pull-down menu ---- |

Quit Looking Glass

An ellipsis (...) after an option on the menu indicates that a dialog

will open when you select that menu option. For example, choos-

ing Operational Preferences from the System menu in the Global

window opens the dialog you use to change some of the ways that

Looking Glass operates.

Choosing a command from a pull-down menu

1. Click the title of the menu you want to access.

2. Click the command you want to select.

A command is selected when it changes color or when it is

enclosed in a three-dimensional rectangle. If a command is

dimmed, you cannot use it.

If you want to close a menu without selecting a command, click

anywhere in the window.

Some of the commands in pull-down menus can be selected with

the keyboard instead of the mouse. For information about using

keystrokes, refer to “Window frame elements” in this chapter.

Option menus

Option menus operate like pull-down menus. However, option

menus appear in dialogs throughout Looking Glass instead of in

menu bars at the tops of windows. The currently selected option is

displayed as a button. Clicking the option displays the rest of the

menu.
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Here is an example of an option menu displayed in a dialog:

Option menu

Choosing a command from an option menu

1. Move the pointer to the option that is showing.

2. Click a mouse button.

The option menu opens.

3. Click the option you want to select.

The menu closes and the option that you chose is displayed in

the dialog.

Pop-up menus

Pop-up menus are similar to option menus because they may appear

anywhere in a dialog. However, pop-up menus display the title of

the menu rather than the currently selected option. When you click

the title, the menu opens.
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Menu title : Symbols

Selecta fies

Pop-up menu - Selectart Directories

Effective User

Effective Group

Current Directory

| Remave | dose | I Rea
aaeemeres soceeores covenenes eanneesee pee:

Choosing a command from a pop-up menu

1. Move the pointer to the menu title that is showing.

2. Click a mouse button.

The pop-up menu opens.

3. Click the option you want to select.

The menu closes and the value that you chose is displayed in

the dialog.

Text boxes

A text box lets you enter or edit information in a dialog by adding,

replacing, or deleting text.

Add Variable
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Adding text to a field

1. Move the pointer to the part of the field that you

want to add text to.

2. Click a mouse button.

A text insertion cursor appears where you clicked in the text

box.

3. Type the new text.

Replacing text in a field

1. Move the pointer to the beginning or end of the text

you want to replace.

2. Hold down a mouse button.

3. Drag across the text you want to replace or double-

click the word you want to replace.

The text is highlighted.

4. Type the new text.

The text you type replaces the highlighted text.

Deleting text in a field

1. Move the pointer to the beginning or end of the text

you want to delete.

2. Drag across the text you want to delete.

3. Press Delete.

Push buttons

Push buttons are used to tell Looking Glass to carry out an action.

The OK and Cancel buttons in dialogs are examples of buttons.

Clicking the OK button tells Looking Glass to process and close a

dialog. Clicking the Cancel button closes a dialog and causes

Looking Glass to ignore any changes you’ve made in the dialog. If a

button is dimmed (grayed), you cannot use it.
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In most dialogs, there is a default button. A default button is the

button that is automatically activated when you press Return unless

you select another button. The default button is always highlighted

with a double border.

Here is an example of a default button in a dialog:

W7/ Remove 2 files?

Default button --------- Ht baeeeuanseeeneuseseaaeneeeeeceeeeeeeedGeseeteenOneeeeeGeaeeESEGAPEEREEEE OE EEEESE OO OS

Selecting a push button

1. Move the pointer to the push button.

2. Click it.

Lists

Some windows contain a list of options you can choose from. Some

lists appear with a text box. The contents of the text box are

replaced by the option you choose from the list.

Here is an example of a typical list in Looking Glass:

Directory:] I

History: /visb/user/nal/Data

{visifusers/hal

/visix/userfhal/Budget

‘visb/user/nal/Budget/Budget_83

/visix/user/hal/Personnel

fvisbvuser/nal/Personnel/Reviews .

‘visb/user/nal/Letters

/visix/user/nal/Letters/Office_Memos

/visbfuserfnal/Archive

A sample list. Ecc ceecaeceeeeed

Open Directory
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A list usually has a title that identifies its purpose. For example, sev-

eral Looking Glass dialogs contain lists of directories that have the

title “History” because they are lists of the directories that you have

visited most recently.

Using a list

1. Click the selection you want to choose in the list.

Your selection is highlighted in the list.

2. Click the appropriate button to activate your

selection.

Your selection is activated.

Radio buttons

Radio buttons offer you a group of options. They appear in dialogs

and on menus. When you turn one on, the others turn off. You can

only select one radio button from a group at a time.

Here is an example of a group of radio buttons:

—T-Act

R wx 0110 --x--x---

P) 0 Biowner [7 Set User ID On Execution

[0 @ croup 1) Set Group ID On Execution

(J (0 others [1] Save Text After Executio:

Radio buttons cece cece eh ceeceeeneeeeeee @ Add © Subtract > Replace

Selecting a radio button

1. Move the pointer to the radio button you want to

select.

2. Click it.
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Check boxes

Check boxes offer one or more options that can be turned on or off

(unlike radio buttons, where turning one on turns the others off).

When a check box is selected, the option associated with the check

box is turned on. When the check box is not selected, the option

associated with the check box is turned off.

Check boxes can also appear on menus as well as dialogs to indicate

whether an option is turned on or off.

fi -Access

Rwx 0110 --x--x---

C1) 0) Hiowner [1] Set User 1D On Execution

Check boxes ~~ -T) (0) Wi Group =‘) Set Group ID On Execution

OOD others 0 Save Text after Execution

@ add © Subtract © Replace

Selecting a check box

1. Move the pointer to the check box you want to select.

2. Chick it.

Scroll bars

Scroll bars allow you to bring hidden information into view. Scroll

bars appear anywhere that text or graphics are displayed but might

not fit in the display area, such as text fields and lists.

Scroll bars contain arrows that you can click on to scroll a line at a

time in a certain direction. They also contain slider boxes that you

can click on and move in order to scroll several windows at a time.
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Here is an example of a scroll bar:

Directory:| |
Arrow eeteteratanetete, Bn ncecececeseceesececst cect A ALAA ONCOL CC CELLO LCCC LCC CAAT CCC CCC eA ee eee eee TO

Scroll bar --------- | Leeeeee History. ‘visivuser/nal/Proposals
/visbvuser/hal/Budget

/visix/user/nal/Budget/Budget_30

/visivuser/nal/Letters/Legal

i fvisix<fuser/nal/Data
fvisi<user/nal

. /visb/us er/fnal/Budget/Budget_83“White” area shows cece cece Ka ccc ccc ccceseavcccechacscceces . g g =

you how much more /visix</user/nal/Personnel
there is to scroll /visix/user/hal/Personnel/Reviews

Change Directory | Cancel | [oxange _]

The size of the slider box in the scroll bar shows you how much of

the available information is currently displayed. For example, if the

slider box fills half of the scroll bar, one-half of the available infor-

mation is shown. If the entire scroll region is filled by the slider

box, all of the available information is shown.

You can use the scroll bar three ways:

¢ Scroll line by line

e Scroll a windowful of information at a time

¢ Scroll to a specific location

Scrolling line by line

1. Move the pointer to one of the arrows.

2, Click the arrow until the information you want is

displayed.

The information scrolls one line in the direction of the arrow

for each click.

Scrolling one window at a time

1. Move the pointer to the scroll region above or below

the slider box.
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2. Click the mouse button.

The information scrolls up or down one windowful of

information.

Scrolling to a specific location

1. Move the pointer to the slider box.

The scroll region represents all the information available. The

slider box in the scroll region shows your relative position in

the information.

2. Drag the slider box up or down to the location you

want to view.

The information scrolls as you drag the slider box.

Scale bars

Scale bars allow you to choose or adjust a value from a range of val-

ues. Scale bars always have an associated text or graphic box that

shows the currently selected value.

Here is an example of a scale bar:

Scale bar

Readout box shows --------

current adjustment | .
Saturation

Drag slide arrow to

adjust value
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Choosing or adjusting a value with a scale bar

1. Drag the slide arrow to the left or right until the

value you want is displayed in the readout box.

The scale bar reflects the value you chose.



Getting help |

This chapter introduces you to the Looking Glass help system and tells you how to ~

ask for help in Looking Glass:

e Using the Help key

e Using the Help command

This chapter also gives you a brief tour of the following windows:

e Help window

e Index window

e History window

You'll learn how to use hypertext links, lists, and control buttons to move through

the help system. Using these navigation tools, you'll be able to:

e Walk through entries in a topic

e Jump to related entries

e Retrace your steps along the path you've created
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Entering the help system

There are two ways to enter the help system:

e Using the Help key

e Using the Help command

Using the Help key

When you enter the help system by pressing the Help or F1 key,

you can indicate the topic you want help on by clicking in an area

of the current dialog or window.

1. To enter the help system, press the Help or F1 Key.

If your keyboard doesn’t have either of these Keys, press:

e Control+Shift+?

or

e Control+Shift+_

The pointer becomes a question mark and the areas for which

help is available are shaded.

Here is an example of the Find dialog after pressing the Help or F1
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2. Put the period of the question mark on the area you

want help on and click.

The help entry for the component you clicked is displayed in a

Help window.

. ee ere aces Btielp o on table of contents mars Fl.

8 Section: toa List of items found | tiyperpath | @
List of items found

The box at the bottom of the Find dialog contains the

list of items found.

As it finds directories or files that match the name

pattern you specified, Looking Glass displays them in

the list.

You can then select any item from this list and use the

Show button to have Looking Glass show itina

Directory window.

ete [letei] =|

A new Help window is opened each time you use the Help key.

Once you're in the help system, you can move to other entries

using the buttons in a Help window or by using the lists in the

Index window. For more information on how to navigate, refer

to “Navigating through the help system” later in this chapter.

3. Click Close to leave the window.

Using the Help command

When you enter the help system using the Help command, a help
window opens displaying the Introduction to Help topic.

1. Choose Help from the Show menu in the Global

window.
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A Help window opens, displaying the Introduction to Help topic.

Once you’re in the help system, you can move to other entries

using the buttons or hypertext links in a Help window or the

lists in the Index window. For more information on how to

navigate, refer to “Navigating through the help system” later in

this chapter.

2. Click Close to leave the window.

A brief tour of the help system

Looking Glass’s help system contains descriptions of all its com-

mands and functions. It is designed to help you find information

for a specific topic quickly, but you can also use it to browse and

learn about Looking Glass.

The Looking Glass help system is composed of three types of

windows:

e Help windows

e An Index window

e A History window

Help windows

When you ask for help on a particular topic using the Help key, a

Help window is displayed. The Help window contains the descrip-

tion and procedures for using the command, field, dialog, button, or

other object that you asked for help on.

Help window text contains two unique features that let you navi-

gate quickly to other entries:

e Hypertext links

e Indexed keywords

Hypertext links let you jump to a new topic and are indicated by

underlined words in the help text.

Most of the other words in the text are indexed to the Phrases list

in the Index window. You can double-click one of these other (non-

underlined) words to open the Index window and see the topics

that contain information about the word.
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Here is a Help window showing help on the File menu in the

Desktop Panel:

ER EREREEEEEE Help on table of contents aia: rar

Section: | 41 1 File menu (Desktop Panel)

File menu

The File menu in the Desktop Panel lets you control

the general operation of the Desktop Panel. With this

menu, you can open, show, and print applications,

directories, and files. You can also close the Desktop

Panel.

The File menu contains the following commands:

For information on any of the commands in the File

topic ] History

[eye] (Ce) Cane |

You can have several Help windows open on your workspace for

different entries.

For information on opening a Help window, refer to “Entering the

help system” earlier in this chapter.

The Index window

Once you've entered the help system by opening a Help window,

you can click the Index button at the bottom of the window to

open the Index window. The Index window gives you access to all

of the topics and subtopics in the help system. It also contains a list

of keywords and phrases you can choose from if you’re not sure of

the particular subject you want help on.

When you first open the Index window, the items highlighted in

the open Index window reflect the entry displayed in the active

Help window. If you open a new Help window or select another

topic in the Index window, the Index window selections change to

reflect the entry in the new Help window. When you close the last

open Help window, the Index window also closes.
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Chosen Phrase: Topics:

ee af corte rite 1 Looking Glass
oe 2 Getting Help

Phrases: 3 The Global Window
sort . 4 Cesktop Panel

splitter 9 Directory Windows

stack 6 Tree View window

status change 7 Layouts

stop _

subtree Subtopics:
super- user functions 4.1 Desktop Panel Overview

symbols SMe MSM OBL et) ae,

system 4.1.1.1 Gose command (Desktop P

4.1.1.2 Open command (Desktop Pane§ |

terminate 4.1.1.4 Print command (Desktop Panel |

text box 4.1.15 Take Off Desktop Panel comm -

4.1.2 View menu (Desktop Panel) .

table of co i eine

time

tree 4.1.2.1 Name and Icon options

tree view 4.122 Show Full Path Name | checkbo C
view — _
window Related Subtopics:

window size 4.1.1.1 Close command (Desktop Panel)

window title 4.1.1.2 Open command (Desktop Panel)

write 4.1.1.3. Show command (Desktop Panel)

{ History... | [ Restore | :

One of the most important components of this window is the

Phrases list. Use the Phrases list in the Index window when you

know the task or object that you want information on but you

don’t know which topic to select. When you select a phrase from

the Phrases list, the Index window selections change to reflect the

chosen phrase.

The Phrases list contains:

e Looking Glass concepts

e Operating system concepts

e Window manager concepts
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The list contains the names of specific Looking Glass components,

like:

e Windows

e Commands

e Dialogs

¢ Components of windows and dialogs, such as text boxes, list

boxes, and buttons

The list also contains common tasks and new features. Select the

“table of contents” phrase to see the complete list of entries in the

Topics and Subtopics lists.

NOTE:

The Help window text also contains invisible links to all of the key-

words in the Phrases list. You can double-click almost any word in a

Help window to open the Index window and see which topics con-

tain information about that word.

If you've changed the topic, subtopic, or chosen phrase in the

Index window during your search for a particular entry, you can

change the lists back to reflect the entry displayed in the Help win-

dow by clicking the Restore button.

There is only one Index window in the help system. If you select

the Index button again from another Help window, the Index win-

dow moves to the foreground. The Index window selections change

to reflect the entry in the active Help window.

The History window

The History window shows you all of the topics and subtopics that

you've visited. You can use this window to see where you've been

or select an entry from the list to open a Help window for that

topic.
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Select an entry to

show in a new Help
window

Here is an example of a History window:

Chosen Phrase: table of contents

Subtopics:

1.1 Looking Glass overview

8.1.12 Close button

4.1.1 File menu (Desktop Panel)

5.1 Directory windows

iin a ood SO GT

6.1.1 Directory menu

6.1 Tree View window

5.1.1.2.2 File/Directory Icon

4.1 Desktop Pane! Overview

3.1.1.4 Creation Preferences command

3.1.1.5 Cleanup Preferences command

3.1.1.2 Removal Preferences command

3.1.1.3.3 Data Editor field

3.1.1.3.2 Text Editor field

3.1.1.3.1 Terminal Program field

You can only have one History window open. If you select the

History button again from the Index window, the History window

moves to the foreground.

The History window stays open when you close the Help or Index

window. When you quit Looking Glass, the contents of the History

window are saved and restored the next time you use the help

system.

Navigating through the help system

The Looking Glass help system contains the following major topics:

e Looking Glass overview

e Getting help

e The Global window

e The Desktop Panel

e Directory windows

e The Tree View window

e Layouts

e Finding directories and files

e Error messages
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Each topic is divided into subtopics that provide general informa-

tion for that topic, and the subtopics may be broken down further

for more detailed information. For example, the Global window

topic is broken down into subtopics describing the menus in the

window. Each subtopic about a menu contains a description of the

commands in that menu. :

When you enter the help system, you start in a Help window. The

information displayed in the Help window depends on how you

access help.

If you enter the help system by pressing the Help or F1 key, you'll

jump right into a Help window describing the component you

clicked. If you use the Help command from the Global window, a

help window opens displaying the Introduction to Help topic.

No matter where you start from, you can navigate quickly to other

entries.

There are two basic ways to move through the help system:

e Walking

e Jumping

Walking is simply moving through the list of subtopics within a

topic. You can move backward and forward in this list using the

Subtopic arrows at the bottom of the Help window. You can see

where you are in the list by using the Section menu at the top of

the Help window.

Jumping \ets you move to entries that may not be in the same

subtopic. The two main ways of jumping are using hypertext links

in a Help window or using the Subtopics list in the Index window.

When you leave an entry that you’ve jumped to, the entry is added

to the Hyperpath menu.

You can also detour from walking and jumping by opening a new

Help window from the History window. You can then navigate

through the new Help window by walking or jumping.

Walking through subtopics

There are two ways you can ask for help on other subtopics within

the same topic using a Help window. You can use:

e Subtopic arrows

e History arrows
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Using the Subtopic arrows

Use the arrow buttons in the Subtopic area at the bottom of the

Help window to move to the previous or next entry.

Here is a Help window with the subtopic area identified:

Macecacet bosewonsaeeeognsaustes tse SeSnQNCES Hada wecemenee este eee Ouse fee

Miticip 0 on “table. of "contents a Pas

7 Section: [6.1 1 Directory menu |

Directory menu

The Directory menu in the Tree View window lets you

open and close selected directories in the Tree View

window.

You can also open selected directories in their own

Directory windows and close the Tree View window

from the Directory menu.

The Directory menu contains the following

commands:

* Open In Tree
* Close In Tree
* Show In Tree

| * Open In Window

Subtopic area ql eecedeceeccsecseessnspevenceseneces foc History -

| Ce] 121] | [#} [)] Coe

The entries in the subtopic you’re in depend on the word high-

lighted in the Phrases list in the Index window. Therefore, as you

walk through the entries in the subtopic, you'll skip any entries

that aren’t related to the word in the Phrases list.

1. In the Subtopic area at the bottom of the Help window,

click:

e The left arrow to move to the previous entry in the subtopic

or

e The right arrow to move to the next entry in the subtopic

2. Continue clicking until you reach the entry you want

help on.

When you reach the end of a topic going in either direction,

the arrow is dimmed. You must use the Topics list in the Index

window to switch to a new topic. For information on using the

Index window, refer to the “Jumping to different subtopics”

section later in this chapter.
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Using the History arrows

As you move through entries in a Help window, the window keeps

track of the entries you visit. Use the arrow buttons in the History

area at the bottom of the Help window to move to the previous or

next entry in the window’s history list.

Here is a Help window with the History area identified:

SEE ein on table of contents Hee seen ae

Directory menu

The Directory menu in the Tree View window lets you

open and close selected directories in the Tree View

window.

You can also open selected directories in their own

Directory windows and close the Tree View window

from the Directory menu.

The Directory menu contains the following
commands:

-~- History —-

[LetHistory area

NOTE:

If you move to another entry by any means other than the History

arrows, all of the forward history disappears, as if you were never

there.

1. In the History area at the bottom of the Help window,

click:

e The left arrow to restore the last entry

or

e The right arrow to return to where you were before you

clicked the left arrow

2. Continue clicking until you reach the entry you want

help on.

When you reach the end of the window’s history list going in

either direction, the arrow is dimmed.
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Jumping to different subtopics

There are two basic ways to jump to a related entry in the help

system:

e Using the Index window

e Using hypertext links in a Help window

You can see where you are in the current subtopic by using the

Section menu at the top of the Help window. You can then select

another entry in the menu to jump to. You can also see where you

are in the hyperpath by using the Hyperpath menu at the top of the

Help window, and then select an entry to jump back to.

Using the Index window

You can open the Index window and choose a new entry from the

Subtopics list to jump to. For information on opening the Index

window, refer to “A brief tour of the help system” earlier in this

chapter.

When you open the Index window, the name of the subtopic that

is currently displayed in the Help window is highlighted.
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Here is an example of an Index window:

Chosen Phrase field ----- 1 Looking Glass

2 Getting Help

3 The Global Window

sort A aera
splitter 3 Directory Windows

. . . stack 6 Tree View window
List of available topics voce eee cece ; ialus change beeee ut

stop
Subtopics:subtree n

super-user functiong Be PS) ics CU
symbols 4.1.1 File menu (Desktop Panel)

system 4.1.1.1 Gose command (Desktop Pane

i 19] [=n sh ol) 4.1.1.2 Open command (Desktop Pane§

terminal emulator 4.1.1.3 Show command (Desktop Pang
4.1.1.4 Print command (Desktop Panel

i covencse Maeno N, JENMINARE. aren roroore swobeomenonence - |
Subtopics of ae text box 4.1.1.5 Take Off Desktop Panel comm

time 4.1.2 View menu (Desktop Panel)

tree ! 4.1.2.1 Name and Icon options

tree view 4.1.22 Show Full Path Name checkbo i
view —- “—

window size i 9.1.1.10 Put On Desktop Panel comman
window title 3.1.4.1 Desktop Panel option

Ue PEERY PREP POPeL eee eee Pee ee rere eee eee eeeSubtopics related to --------
chosen subtopic 4.1.1 File menu (Desktop Panel)

1. Select “table of contents” from the Phrases list.

The Topics list changes to display all of the topics in the help

system.

2. From the Topics list, select the topic that contains the

subtopics you want to see.

You can use the scroll bar on the side to move down the list.

3. From the Subtopics list, select the subtopic that you

want to see.

You can use the scroll bar on the side to move down the list.
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Underlined phrases

indicate hypertext
links

feces ewe pees

4. Click Show.

The entry you selected is displayed in the Help window.

Using the Help window

In addition to using the Index window for jumping to other

subtopics, you can use hypertext links in a Help window.

You can also use the Section menu to jump to any entry within the

current subtopic and the Hyperpath menu to return to any entry

already in your hyperpath.

Using hypertext links

Hypertext links appear in a Help window and allow you to jump to

a new related entry. Links are like threads that connect two entries

and are indicated by underlined words in the help text.

Many other words in the text are indexed to the Phrases list in the

Index window. You can double-click one of these other (non-under-

lined) words to open the Index window and see the topics that con-

tain information about the word.

Here is a typical Help window that contains hypertext links:

Bictp on table of contents aaa Cala

Section: [6.1 1 Directory menu | Hyperpath

Directory menu

The Directory menu in the Tree View window lets you

open and close selected directories in the Tree View

window.

You can also open selected directories in their own

Directory windows and close the Tree View window

from the Directory menu.

The Directory menu contains the following

commands:

«

Open In Tree

Le? | Le I> Close Jy

ubtopic ce [Ce History
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1. In the Help window, double-click anywhere in the

underlined phrase that you want more help on.

The entry you selected is displayed in the Help window and the

entry you jumped from becomes part of the hyperpath.

Using the Section menu

The Section menu is an option menu that displays the name of the

help entry currently showing in the Help window. The menu con-

tains the topic above and all of the entries directly below the

subtopic showing. Entries are dimmed in the Section menu if they

aren’t related to the chosen phrase in the Index window.

When you click the Section menu, the menu opens and you can

jump to another entry.

Here is an example of a Help window with the Section menu open:

aS Tree View window

Section menu eeecanece eee ccateresvonces 1.6.1 Tree View window

| Section: 6.1 .1 Directory menu

7 6.1.1.1 Open in Tree command

Direct 6.1.1.2 Gose in Tree command
The Dire 6.1.1.3 Show In Tree command low lets you

open ang 6.1.1.4 Open In Window command fee View

window 6.1.1.5 Cose Tree View command

You can also open selected directories in their own

Directory windows and close the Tree View window

from the Directory menu.

The Directory menu contains the following

commands:

* Open In Tree

* Show In Tree
* Wi

topic

€} >)

1. Click the entry showing in the Section menu.

The menu opens displaying the all of the subtopics above and

all of the entries below the current entry.
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Hyperpath menu
showing help entries

you've visited recently

2. Select the entry you want help on.

The entry you selected is displayed in the Help window and the

entry you jumped from becomes part of the hyperpath.

Using the Hyperpath menu

You can see the entries you jumped from by using the Hyperpath

menu at the top of the Help window. If you use this menu to go

back to one of the entries you jumped from, all of the entries that

followed it in the menu disappear from the Hyperpath menu. The

Hyperpath menu will then reflect any new places you jump from.

You can use the History arrows to retrace your steps back to the

hyperpath jumps that disappeared from the menu.

NOTE:

If you’ve only walked through the entries in a subtopic and haven’t

jumped to any entries outside the subtopic, the Hyperpath menu is

dimmed.

g Section: [6.1.4 Directory menu Hyperrath

- 1.1 Looking Glass overview

- Directory menu 6.1 Tree View window

The Directory menu in the Tree View window lets you

open and close selected directories in the Tree View

window.

You can also open selected directories in their own

Directory windows and close the Tree View window

from the Directory menu.

The Directory menu contains the following

commands:

* Open In Tree

* Show In Tree

ubtopic ] History

Leh >t) | LOIL%]) Loose _ |

1. Click Hyperpath.

The menu opens, displaying all of the help entries in your

hyperpath in the order that you jumped from them. The entry

you visited most recently is displayed at the bottom of the

menu.
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2. Select an entry you want to return to.

The entry you selected is displayed in the Help window.

All of the entries below the one you selected in the hyperpath

are removed from the Hyperpath menu. The menu now con-

tains only the entries that you visited before the one you

selected.

Detouring using the History window

You can detour from walking or jumping through entries by open-

ing a new Help window from the History window. The help system

History window is similar to other history lists in Looking Glass in

that it lets you quickly select a help entry that you've visited. The

most recently visited entry is always at the top of the list. However,

unlike directory history lists that store only a limited number of

directories, the help system History window records every help

entry that you've ever visited.

When you select a help entry from the History window, a new Help

window is opened. You can then navigate through the new Help

window by walking or jumping.

For information on opening the History window, refer to “A brief

tour of the help system” earlier in this chapter.

To open a new Help window from the History window:

1. Select an entry from the list that you want to return to.

2. Click Show.

A new Help window opens, displaying the entry you selected.





Working with Directory windows

In this chapter, we'll introduce you to Looking Glass Directory windows and tell you

how to perform these basic operations:

Opening directories in new Directory windows

Closing Directory windows

Changing the directory displayed in the current Directory window

Moving a Directory window to the foreground on your workspace

Stacking Directory windows on your workspace

You'll also learn how to customize the display of directories and files in Directory

windows by:

Setting display formats

e Choosing whether to show or hide hidden files

e Adjusting the amount of space used to display the directory and file sections in a

Directory window

Sorting directories by a category such as name, time the file was last changed, or file

type
Grouping selected directories and files

Positioning icons in a Directory window

Assigning colors to directory and file icons
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Introducing Directory windows

You’ll do most of your work in Looking Glass Directory windows.

Each Directory window contains the subdirectories and files of a

single directory.

In Looking Glass, there is no one “current directory.” The “current

directory” in each Directory window is the directory whose contents

are displayed in the window. By default, the full pathname of this

directory is displayed in the title bar of each window. As part of your

display preferences, you can choose the information you want to

display in the title bar of the window. For information about display

preferences, refer to “Changing display preferences” in Chapter 12,

“Changing Looking Glass preferences.”

In the directory section of each Directory window, the “current

directory” is represented by “.” (dot).

The directory that contains the “current directory” in each

Directory window is called the parent directory. In the directory

section of a Directory window, the parent directory is represented

by “..” (dot dot).

Here is an example of the current and parent directories in a

Directory window:

Current directory += i Cia)

P arent d i rectory satetereteteteten OB oe cnrssreretetenetetenatets ‘ ee: ”
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The first time you open a Directory window, your default display

preferences determine what the window looks like. You can then

use the File, View, Sort, and Color menus in the Directory window

to set display variables such as:

e The directory displayed in the Directory window

e Whether directories and files are displayed in Name, Icon, or

Wide view

¢ Whether the Directory window contains the splitter or is in the

positionable format

¢ The order that directories and files are displayed in a split window

e The colors of the icons in Name, Icon, or Wide view

Looking Glass remembers the Directory window’s position on the

workspace and display settings when you open the window again.

Opening Directory windows

The first time you start Looking Glass, the directories and files in

your home directory are displayed in a Directory window.

As you work with Looking Glass, you can display as many Directory

windows as you want.

There are three ways to open Directory windows:

¢ Double-click any directory you want to open in a Directory

window

¢ Use the Open command from the File menu in any Directory

window

e Use the Open Directory command from the Windows menu in

the Global window

Opening Directory windows by double-clicking

Double-clicking is the easiest way to open a single Directory win-

dow at a time. You can double-click any directory displayed on the

workspace.

i. In a Directory window or the Desktop Panel, double-

click the icon for the directory you want to display in

the new window.
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The new Directory window opens, displaying the contents of

the directory you double-clicked.

If you want to change the action associated with double-clicking,

use the Operational Preferences command in the System menu. For

more information about the Operational Preferences command,

refer to “Changing operational preferences” in Chapter 12,

“Changing Looking Glass preferences.”

Opening Directory windows using the Open command

The Open command in the File menu of a Directory window is the

most efficient way to open more than one directory at a time when

those directories are displayed in the same Directory window.

1. In a Directory window, select the directories you want

to open.

2. Choose Open from the File menu in the Directory

window.

A Directory window opens for each directory you selected.

Opening Directory windows using the Open Directory command

The Open Directory command in the Windows menu of the Global

window opens a dialog containing a history list of recently visited

directories. Use this command to select a directory that is not acces-

sible in the workspace.

1. Choose Open Directory from the Windows menu in the

Global window.
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The Open Directory dialog is displayed:

nnneroahDirectory :/usr/nal/Proposalg

History: | /usr/hal/Personnel

/usi/nal/Personnel/Benefits

PUSteh al Props ats

fustMmal/Data

fusrfnal/misc

/ustnal/Budget

fusfhal

Open Directory |__ Cancel } |L__open
2000 Seton CtEEESeRTEE ERERER

In this dialog, you specify the directory you want to open in

the new Directory window.

2. To specify the directory you want to open:

e Select a directory from the history list

or

e Enter the pathname of a directory in the Directory field (as

a shortcut, you can leave this field blank to change to your

home directory)

3. Click Open.

A Directory window opens for the directory you selected.

Closing Directory windows

1. Choose Close from the File menu in the Directory win-

dow you want to close.

The Directory window closes.
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Changing the directory displayed in the current Directory window

There are two ways to change the directory displayed in a Directory

window:

e Double-click a directory

e Use the Change Directory command

Changing directories by double-clicking

1. Control+double-click the icon or name of the direc-
tory you want to display.

The directory you double-clicked is displayed in the current

Directory window.

If you want to display the contents of a directory in a new Directory

window, refer to “Opening Directory windows” earlier in this chapter.

If you want to change the action associated with the Change Directory

command, refer to “Changing operational preferences” in Chapter 12,

“Changing Looking Glass preferences.”

Changing directories using the Change Directory command

1. Choose Change Directory from the File menu in a

Directory window.

The Change Directory dialog is displayed:

Directory: /usrmali etierd |

Sus hablL etters

fusr/nal/Letters/P ersonal

fust/nal/Proposals

fust/hna/Data

fust/hal/misc

/ust/nal/Budget

/ust/nal

Change Directory | Cancel ] [Coxange_]

In this dialog, you specify the directory you want to change to.
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2. To specify the directory you want to change to:

e Select a directory from the history list

or

e Enter the pathname of the new directory in the Directory

field (as a shortcut, you can leave this field blank to change

to your home directory)

3. Click Change.

The new directory is displayed in the current Directory window.

Moving Directory windows

If you have several Directory windows open on your workspace,

you can use the Windows menu in the Global window to move a

window from the back of the group to the front. You can also use

the Windows menu to stack all of the Directory windows neatly on

the workspace.

Moving a Directory window to the foreground

The Windows menu in the Global window lists the names of all the

directories that are currently open on your workspace. You can

choose the name of one of these directories to move it in front of

the other windows.

1. Choose the name of the directory you want to move to

the front from the Windows menu in the Global

window.

The directory you chose is moved in front of the other windows

on the workspace.
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Stacking Directory windows

At your request, Looking Glass stacks any open Directory windows

neatly on the left side of the screen.

1. Choose Stack from the Windows menu in the Global

window.

Your open Directory windows are neatly stacked on your

workspace. Here is an example of stacked windows:

Budget_83 Budget_90

Changing display formats in Directory windows

In Directory windows, there are three ways to display directories

and files:

e Name view

e Icon view

e Wide view
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; eS. & Archive

Budget © Data © Letters

Personnel © Proposals © bin

Acme_Letter & Ad_Copy a Appointments

2 Client_List ® Forecast = Phone_List

2 Sales_Leads ® Staffing Plan © To_Do

Zycor_Letter ,

View by icon

When directories and files are displayed in Icon view, a full-size

icon is displayed for each object in a Directory window. The name

appears below the icon.

1. Choose Icon from the View menu in a Directory

window.

The directories and files in the current Directory window are

displayed by Icon.
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Here is an example of directories and files that are displayed by

icon:

Spo TTT
at

Fie Greate View Sort Select Run Color

(J CL)
Data Letters Personnel Proposals

Directories and files
displayed in Icon ic

ven e
Acme _Letier Ad_Copy Appointments Client_ List

Forecast Phone_List Sales_Leads Staffing Pian

S
To_Do zycor_Letter
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Archive

Budget

dsgp
system

dsgrp

dsgrp

asgrp

dsgrp

1024 15:09

Siz 18:21

512 18:58

512 11:50

912 21:31

o12 13.03

Nov 15 1980

Nov 13 19930

Jui 26 1990

Nov 14 1890

Noy 13 1930

Nov 13 1990

Directory

Directory

Directory

Directory

Directory

Directory

Acme_Letter

Ad_Copy

8 Appointments w-

Client_List rw-

Forecast rw

Phone_List fw-

Sales_Leads mw-

Staffing Plan nw-

To_Do tw

dsgrp

dsgrp

dsgmp

dsgrp

dsgrp

dsgrp

asgrp

dsgrp

339 12:53

4827 11:32

234 13:15

18173 11:37

4848 13:38

3018 12:48

34397 12:58

1825 13:01

Mar 14 1990

Apr 26 1990

Nov 2 1990

Sep 25 1890

Dec 20 1989

Aug 5 1986

Feb 26 1990

Jun 26 1990

Nov 21990

Text file

Text fie

Desktop calendar doc

Card file

Spreadsheet data file

Card file

Database data file

Spreadsheet data file

Card file



Choosing whether to show or hide hidden files

Hidden files are directories and files whose names begin with “.”

(with the exception of the current and parent directories). The “.”

prefix is often used in naming system configuration files or data

files that users rarely need to view.

Use the Show Hidden Files check box in the View menu to show or

hide the hidden files in the active Directory window. If this check

box is selected, hidden files are displayed; if the check box is not

selected, hidden files are hidden.

1. Select or unselect the Show Hidden Files check box in
the View menu in the Directory window.

If you selected the check box, hidden files are displayed; if you

unselected the check box, hidden files are hidden.

If you want to change whether hidden files are displayed by

default, refer to “Specifying whether hidden files are displayed in

Directory windows” in Chapter 12, “Changing Looking Glass

preferences.”
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File Greate View Sort Select Run Color

. be

Cleaning up repositioned directories and files

You can align any directories or files that you’ve repositioned

according to your cleanup preferences using the Clean Up com-

mands from the Sort menu. For more information about setting

your cleanup preferences, refer to Chapter 12, “Changing Looking

Glass preferences.”
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You can only use the Clean Up commands in Positionable format.

You can clean up all directories and files in Name or Icon view. You

can also select specific directories or files to clean up.

Cleaning up using the Clean Up command

1. Select Clean Up from the Sort menu in the Directory

window you want to clean up.

All the directories and files are arranged in neat rows and

columns on an invisible grid, filling in the Directory window

from left to right and top to bottom.

Cleaning up using the Clean Up Selection command

1. Select the directories or files you want to clean up.

2. Choose Clean Up Selection from the Sort menu in the

Directory window you want to clean up.

The directories and files you selected are moved to the nearest

available space on the grid—not necessarily filling in the

Directory window from left to right and top to bottom.



Grouping selected directories and files

Sometimes it is useful to group all selected directories or files in a

Directory window. The Group Selected Objects command groups

any selected directories or files first, then lists the rest of the direc-

tories and files. You can group directories and files in any view in

the Non-positionable format.
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1. Select the directories and files you want displayed if

they are not already selected.

2. Choose Group Selected Objects from the Sort menu in

a Directory window.

The selected directories or files are listed together.

Assigning colors to directories and files

If you have a color display, you can assign colors to directories and

files. When you assign a color to a directory or file, it appears in

that color in Directory windows and the Desktop Panel until you

change it. Assigned colors are stored on a per-user basis, so the col-

ors you assign aren’t seen by other users.

1. Select the directory or file to which you want to

assign a color.

2. Choose a color from the Color menu in a Directory

window.

The selected directory or file is displayed in the color you chose.

Retyping a directory

When Looking Glass first visits a directory, it looks at the files and

directories in it to determine their “type” based on a set of rules

defined at your site. When Looking Glass visits a directory it has

already been in, it only examines files that were added since the last

Visit.

Typing a file correctly is very important because Looking Glass uses

the type information in several ways, including:

e To display the correct icon when files are viewed by icon

¢ To carry out the correct action when files are activated

¢ To determine whether files are “printable” and to print them

correctly

¢ To determine whether a program needs to be run in a terminal

emulator window
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There may be occasions when you want Looking Glass to “retype” a

directory. For example, you would want to retype a directory if new

file typing rules have been defined in your system, and you think

that you may have some files in a directory that may be typed more

effectively based on the new rules.

1. Open the directory you want to retype in the current

Directory window. |

2. Choose Retype Directory from the File menu.

The directory is retyped.



Managing directories and files

In this chapter, you’ll learn how to manage the directories and files in your Directory

windows.

You'll learn how to:

Create new directories and files

Create links for directories and files

Find and display directories and files in Directory windows

Select directories and files in the active Directory window

Group selected directories and files |

Move files

Copy files

Remove directories and files

Print files

Looking Glass users are limited to creating directories only.
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Creating directories and files

Use the Create menu in a Directory window to create directories,

files, FIFOs, and devices.

NOTE:

If the Directory, File, FIFO, and Device commands are dimmed in

the Create menu, you do not have write permission for the current

directory. For more information about access permissions, refer to

Chapter 7, “Accessing information about directories and files.”

Creating directories

1. Choose Directory from the Create menu in a Directory

window.

The new directory is named Directory1 and its name is selected.

Each new directory you create is consecutively numbered until

you rename it.
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@ Block Device

© character Device

Major Device Number:[ —_|

Minor Device Number: [

Changing the name of an existing directory or file

There are two ways to change the name of a directory or file using

Looking Glass:

e Edit the name in a Directory window

e Use the Information command
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The following section tells you how to change the name of a

directory or file in a Directory window. To find out how to

use the Information command to change a directory or file’s

name, refer to Chapter 7, “Accessing information about

directories and files.”

1. Select the name of the directory or file you want

to change.

A box appears around the directory or file name and the

name is highlighted.

2. Edit the name just as you would any text field.

Looking Glass allows you to change the name of all

directories and files in your directory except the “.”

(current) and “..” (parent) directories.
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:| /usr/nalData

fusrfhal/ig

fusr/nal/misc

fusr/nal/PersonnelLitigation

/usr/nal/Personnel

fusr/nal/Personne/Handbook

fusr

fusr/nal

LiuschaliPronnsals

Link Type: ® Hard © Relative Symbolic © Absolute Symbolic
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History: | /usr

/

fust/hal/Data

/ust/nal/Personnel

fusr/nal/Personnel/Benefits

/usr/nal/Letters

/ust/nal/Letters/P ersonal

fust/hal/Proposals

iuisihalimisc LZ!

link Type: <} Hard @ Relative Symbolic © Absolute Symbolic
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Files Symbolic Links [J Sockets

Directories Devices EE FIFOs
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Grouping selected directories and files

Sometimes it is useful to group all selected directories or files in a

Directory window. The Group Selected Objects command groups

any selected directories or files first, then lists the rest of the direc-

tories and files. This command is only available when the Directory

window contains the splitter (in other words, when Positionable is

not selected in the View menu).
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1. If the directories and files you want displayed first are

not already selected, select them.

2. Choose Group Selected Objects from the Sort menu in

the Directory window.

and files are brought
to the top of lists

Selected directories «77 ~ |

Moving and copying files

In Looking Glass, you can move and copy files by using mouse

actions or the Move and Copy commands from the File menu.

Moving files

There are two ways to move a file from one directory to another:

e Drag the file to its new location

e Use the Move command
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Moving files by dragging

If the directory you want to move a file into is displayed on your

workspace, you can drag the file to its new location.

1. Select the files you want to move.

2. Drag the selected files to:

e The file section of a Directory window

° The name or icon of a directory in a Directory window or
the Desktop Panel

If you move large files or several files at one time, a status

dialog displays the progress of the move operation.

If a status dialog is displayed, you can cancel the unfinished

part of the move operation by clicking Cancel in the dialog.

Moving files with the Move command

1. Select the files you want to move.

2. Choose Move from the File menu in the Directory

window.

The Move dialog is displayed:

Move To:|

History: fvisix/user/hal/misc

/visbuser/hal/Proposals

‘vish/user/hal/Budget

fvish/user/hal/Budget/Budget_30

‘visix/user/hal/L etters

fvisb/user/hal/L etters/Legal

‘visb/user/hal/Data

fvisix/user/nal

/visifuser/hal/Budget/Budget_689

fvisix/user/hal/Personnel

Move Files to Directory
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3. To specify the directory you want to move files to:

e Select a directory from the history list

or

e In the Move To field, enter a new filename or the path-

name of a directory

or

e Press Return to move the files to your home directory

4, Click Move.

If you move large files or several files at one time, a status

dialog displays the progress of the move operation.

If a status dialog is displayed, you can cancel the unfinished

part of the move operation by clicking Cancel in the dialog.

Copying files

There are two ways to copy files in Looking Glass:

e Drag them

e Use the Copy command

Copying files by dragging

If the directory you want to copy a file into is displayed on your

workspace, you can drag the file to the new location to put a copy

of it there.

1. Select the files you want to copy.

2. Hold down the Control key.

3. Drag the files to:

e The file section of a Directory window

e The name or icon of a directory in a Directory window or
the Desktop Panel

If you copy large files or several files at one time, a status dialog

displays the progress of the copy operation.

If a status dialog is displayed, you can cancel the unfinished

part of the copy operation by clicking Cancel in the dialog.
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Copying files with the Copy command

1. Select the files you want to copy.

2. Choose Copy from the File menu in the Directory

window.

The Copy dialog is displayed:

Copy To:| |

History: ‘visb/user/nal/misc

‘visb/user/nal/Proposals

‘visb/user/nal/Budget

‘visb¥user/nal/Budget/Budget_30

‘visb/user/nal/Letters

‘/visbfuser/nal/Letters/Legal

/visduser/nal/Data

/visi</user/nal

/visb/user/nal/Budgel/Budget_83

‘visix/user/nal/Personnel

[rrreareoeseseresecossnassanasmoneans §

Copy Files to Directory |_cancet_| lL_cory_]}

In this dialog, you specify the directory or file that you want to

copy to.

3. To specify the directory or file you want to copy to:

e Select a directory from the history list

or

e In the Copy To field, enter a new filename or the path-

name of a directory

or

e Press Return to copy the selected directories and files to

your home directory

4, Click Copy.

If you copy large files or several files at one time, a status dialog

displays the progress of the copy operation.

If a status dialog is displayed, you can cancel the unfinished

part of the copy operation by clicking Cancel in the dialog.
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Removing directories and files

In Looking Glass, you can delete directories and files from your sys-

tem with the Remove command from the File menu.

WARNING:

When you remove a file, it is deleted permanently. When you

remove a directory, the directory and all of the files and subdirecto-

ries it contains are deleted permanently.

If you accidentally remove something, see your system administra-

tor—it may be recoverable from a backup.

1. Select the directories and files you want to remove.

2. Choose Remove from the File menu in the Directory

window.

One or more confirmation dialogs may be displayed.

If you select directories and files, Looking Glass displays a dia-

log asking you if you really want to remove both directories and

files. Other dialogs may be displayed, depending on the level of

confirmation selected in your removal preferences. For more

information about setting removal preferences, refer to “Setting

removal preferences” in Chapter 12, “Changing Looking Glass

preferences.”

3. In a confirmation dialog, click:

e Yes to confirm the removal

or

e No to cancel the removal

If you remove large directories and files or several directories

and files at one time, a status dialog displays the progress of the

remove operation.

If a status dialog is displayed, you can cancel the unfinished

part of the remove operation by clicking Cancel in the dialog.
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Printing files

You can print files with the Print command from the File menu.

1. Select the files you want to print.

2. Choose Print from the File menu in the Directory

window.

Looking Glass prints the files. If you select a file that is not printable,

Looking Glass displays a dialog telling you that it won’t be printed.

When Looking Glass prints a file, it uses two commands: one to for-

mat the file and one to spool it to the printer. You can specify the

print formatter and spooler commands as part of your execution

preferences. For information about execution preferences, refer to

Chapter 12, “Changing Looking Glass preferences.”

The formatter command processes the file for printing—it may pagi-

nate the document or put in headers. The spooler receives the data

produced by the formatter command and sends it to the printer.

When you choose the Print command from the File menu, Looking

Glass checks to see if the file is printable. If it is, Looking Glass

checks to see if a special formatting command is defined for that

type of file. If there is one, Looking Glass uses it. If there is no spe-

cial command, Looking Glass uses the command from the user’s

execution preferences.

The output of the formatting step is then sent to the spooler com-

mand specified in the user’s execution preferences.





Viewing your file system with

Tree View
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Accessing information about

directories and files

In Chapter 4, “Working with Directory windows,” you learned how to display very

detailed information about directories and files in a Directory window using the

Wide option from the View menu. You learned that you can change the name of a
directory or file displayed in a Directory window.

In this chapter, you'll learn how to view and change other information about a sin-

gle directory or file or a group of directories or files.

You'll learn how to use the Information command to view and change information

one directory or file at a time. If you select a group of directories and files at one

time, an Information dialog is displayed for each directory and file.
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Accessing information for one directory or file at a time

You can use the Information command in a Directory window to

open a dialog that contains information about any selected direc-

tory or file.

With the Information dialog, you can view the following informa-

tion about a single directory or file:

e Name

e Type

e Size (in bytes)

e¢ Number of links to the directory or file

¢ Inode number (a number used by the operating system to iden-

tify the file)

e Access permissions (also called protection mode)

e Ownership and group reference

e Date and time the directory or file was created

¢ Date and time the status of the directory or file was changed

e Date and time the directory or file was last accessed or changed

® Link information (symbolic links only)

e Reference protection (symbolic links only)

e Device type (devices only)

e Major and minor device numbers (devices only)

You can also change the following using the Information dialog:

e Name |

e Access permissions (also called protection mode)

e Ownership and group reference

e Date and time the directory or file was last accessed or changed

° Link information (symbolic links only)

e Reference protection (symbolic links only)

e Device type (devices only)

e Major and minor device numbers (devices only)

Looking Glass users can view information about a directory or file,

but cannot change ownership, date, or device information. These

sections of the Information dialog can only be modified by Looking

Glass Professional users.

Viewing information for one directory or file at a time

Use the Information command to view information about selected

directories and files in a Directory window. This section explains

how to access the dialog and how to use it to view information.
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1. In a Directory window, select the directories and files

for which you want to view information.

2. Choose Information from the File menu in the

Directory window.

An Information dialog is displayed for each selected directory

and file. |

Here is an example of an Information dialog:

aan
= information For Sales Leads aia

Name: |Sales_Leads |

Type: Database data file

Size: 54397 Links: 1 inode: 71731

These buttons ... ® access © Ownership © Dates

0644 = rw-r--r--
R WX

HE HC owner [") Set User ID On Execution

control this seneeneeneeateetes MMeseesees HOD croup C] Set Group ID On Execution

information E COC otners [) Save Text After Execution

ne wiematn = [cmc] [oe] |

NOTE:

Device type and device number are only displayed in the

Information dialog if the file is a device.

Notice that the dialog is divided into four sections. The first

and third sections contain information about the selected direc-

tory or file. The second section contains a group of radio but-

tons that control the category of information shown in the

third section:

e The Access button displays access permissions (this is the

default)

e The Ownership button displays the owner and group

reference

e The Dates button displays the status change, access, and

modification dates

e If you’re viewing a device file, the Device button displays

information about devices
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The fourth section contains the OK and Cancel buttons for the

dialog.

3. Click the appropriate button in the second section to

view a different category of information in the third

section of the dialog.

4. Click OK when you’re finished viewing the
information.

The following paragraphs tell you how to change information dis-

played in the Information dialog.

Changing information for one directory or file at a time

This section provides instructions for changing information for one

directory or file at a time using the Information command. You can

change the following information:

e Name of the directory or file

e Access permissions (also called protection mode)

e Ownership and group reference |

e Date and time the directory or file was last accessed or changed

e Link information (symbolic links only)

e Reference protection (symbolic links only)

e Device type (devices only)

e Major and minor device numbers (devices only)

Changing the directory or file name

You can use the Information dialog to change the names of directo-

ries and files.

NOTE:

You can also change the names of directories and files by selecting

the name in a Directory window. When the name is selected, edit

the name.

1. Select the directories and files whose names you want

to change.

2. Choose Information from the File menu in the

Directory window.

An Information dialog is displayed for each selected directory

and file.
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3. Edit the Name field.

4, Click OK.

If you selected more than one directory or file, repeat steps 3

and 4 until no more dialogs are displayed.

Changing access permissions

The access permissions of a directory or file determine who can

read, write, or execute it.

You may want to change access permissions for a directory or file:

e To prevent it from being accidentally or maliciously removed

° To keep it private

e To share it with other users

You can change access permissions for any directory or file you

own. You can assign access permissions to the owner, the members

of a group, and others (other users who aren’t in your group).

The following table summarizes the access permissions you can

assign to directories and files:

If you assign this Fora directory, For a file,

permission: specified users can: specified users can:

R (read) View its contents View its contents

W (write) Put directories or files in it Change its contents

Remove directories or files

from it

X (execute) Search the directory Run it as a command
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Access information

WARNING:

You should only assign execute permission for files that can be used as com-

mands. If you assign execute permission for an ordinary file, there is always

the chance that someone will try to “run” it as a command. Because the file

is “executable,” the shell will interpret its contents as commands.

1. In a Directory window, select the directories and files

for which you want to change access permissions.

2. Choose Information from the File menu in the

Directory window.

An Information dialog is displayed for each selected directory

and file.

3. Select Access.

Nama: iSales_Leads

Type: Database data file

Size: 54397 Links: 1 node: 71731

®@ Access © Ownership > Dates

0644 = rw-r--r--

RW xX

Hi i 0 owner [[] Set User 1D On Execution

Leceewccecconseces Mec cessees Boo Group rT) Set Group ID On Execution

] C others [.) save Text After Execution

[ence] [Lox] |

If the directory or file is a symbolic link, two buttons are dis-

played below the access information: the Link Protection but-

ton and the Reference Protection button. These buttons let you

choose whether to view and set the protection for the link or

for the directory or file it references. For more information

about links, refer to “Creating links for directories and files” in

Chapter 5, “Managing directories and files.”
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The Link Protection button is selected by default. Select the

Reference Protection button if you want to view access informa-

tion for the actual directory or file (the directory or file the link

references).

4. Select:

® R (read) to allow the Owner, Group, or Others to view the

contents of the directory or file.

or

¢W (write) to allow the Owner, Group, or Others to change

the contents of a file, or to put files in or remove files from

a directory

or

° X (execute) to allow the Owner, Group, or Others to run a

file as a command or open a directory

5. Click OK.

If you selected more than one directory or file, repeat steps 3

through 5 until no more dialogs are displayed.

Changing execution options

In addition to viewing the access permissions for a directory or file,

you can also view and change execution options. These options

include:

e The Set User ID On Execution and Set Group ID On Execution

options, which allow other users to execute a program with the

access permissions of the program’s owner or group. These per-

missions should be used with extreme care because they may

give other users control over your files.

e The Save Text After Execution option, which causes an exe-

cutable binary file’s text image to be saved to the swap area on

the disk to speed loading for future invocations of the program.

This attribute (sometimes referred to as the “sticky bit”) has dif-

ferent roles depending on the system you are using.

While these options may only seem meaningful for executable files,

they can also affect directories on some systems.

1. In a Directory window, select the directories and files

for which you want to change the execution options.
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2. Choose Information from the File menu in the

Directory window.

An Information dialog is displayed for each selected directory

and file.

3. Select Access.

The execution options are displayed with the access

information:

[5 REE information For Sales Loads i Esai

, Name: |Sales_Leads | ec
a
=

Type: Database data file

Size: 54397 Links: 1 inode: 71731

@ access © Ownership © Dates

i i . 0644 rwer--r--Execution options a we x :

@ BC owner [] Set User ID On Execution

@ 02 CD Group ["] Set Group ID On Execution

r] (0 others [] Save Text After Execution

Fle information |__cancet_| IL _oK _]

4. Select:

® Set User ID On Execution if you want other users to be

able to execute the file with the owner’s access permissions

or

® Set Group ID On Execution if you want other users to be

able to execute the file with the access permissions of the

owner's group

or

® Save Text After Execution if you want the file’s executable

text image saved to the swap area on the disk after

execution

§. Click OK.

If you selected more than one directory or file, repeat steps 3

through 5 until no more dialogs are displayed.
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Sinforetiet s
e
e

Type: Database data file

Size: 54397 Links: 1 inode: 71731

© Access © Ownership © Dates
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Name: |Sales_Leads

Type: Database data file

Size: 54397 Links: 1 inode: 71731

© access © Ownership @ Dates

Status Change: | 11/13/90 18:20:21

Access: | 11/21/30 s:«16:19:02 |





Chapter 7: Accessing information about directories and files hb. 7-13

Name: 'rzOf

Type: Raw hard disk

Size: 0 Links: 1 inode: 2081

© access © Ownership © Dates @ Device

© Block Device

@ Character Device
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EERIE 0 ormation For rrr

Name: 'rz0f

Type: Raw hard disk

Size: 0 Links: 1 node: 2081

© Access <> Ownership © Dates @ Device





7-16 hb Looking Glass User's Guide

soseteatatereter eter ere eae so se

a
{Access

| awx 000
1) 0 0 owner I] set User 1D On Execution
r] 0 DC Group F} set Graig: ID On Executions

(0 2 ( others C] gave Text After Execution
@ fai © Subtract O Replace |

Last Modified-————"7 t hocessed———
| 41529798 10:52:41

44/29/90 10:52:41
Prewasen

rewt

penne



ectories and files A 7-17
Chapter 7: Accessing information about dir

R WX

ooo
1) CC Group Cc)
£0 DC otters oO

> add © Subtract G Replace

ra t Acces:

11/79/36 14.52:43 44/29/99 19:52:41
tere

(ox _]|
Seemann

Set Group 1D On Execution

Save Text After Execution





Chapter 7: Accessing information about directories and files he 7-19

736



7-20 hh Looking Glass User’s Guide

auuiread

bin

(apm

Owner [] Set User 1D Gn Execution

--4-11/29/90 10:52:41 1729730 30:92:41



s and files y% 7-21
Chapter 7: Accessing information about directorie

~{_}Access

a WX

1] 0 0 owner [] Set User 1D On Execution

r) 01 0 Group [] Set Grog 1D On Execution

COD otners 1) Save Text After Execttton

> fat O Subtract D Replace

t Modifie t Acces

16:32:41 | 11/29/90 , 10:52:41





Running programs

In this chapter, you’ll learn how to use Looking Glass to run and terminate programs

from:

e Directory windows and the Desktop Panel

¢ Command Line dialogs

e¢ Terminal emulator windows

The Command Line dialog is available to Looking Glass Professional users only.
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Activating files

When you activate a file, Looking Glass decides what type of file it is

and runs the correct program. When Looking Glass runs a program,

the program’s icon and process ID are displayed in the Global

window.

You can usually terminate a program started from Looking Glass

with the Request Job Termination or Force Job Termination com-

mands from the Jobs menu in the Global window.

For information on defining the action taken when you activate a

file, refer to Chapter 13, “Defining file types.”

There are two ways to activate a file in Looking Glass:

¢ Double-click the file

e Use the Open command

Activating files by double-clicking

1. In a Directory window or the Desktop Panel, double-

click the file you want to activate.

If there are no actions associated with the file, Looking Glass

displays a dialog telling you that.

If there are actions associated with the file, the file is activated

and Looking Glass displays the icon for the program associated

with the file in the Global window.

Activating files using the Open command

1. In a Directory window or the Desktop Panel, select the

files you want to activate.

2. Choose Open from the File menu in the Directory

window.

If there are no actions associated with a file, Looking Glass dis-

plays a dialog telling you that. |

If there are actions associated with the files, the files are acti-

vated and Looking Glass displays the icons for the programs

associated with the files in the Global window.



Chapter 8: Running programs he. 8-3

Displaying and choosing actions for a file

Some files have more than one action associated with them. The

action that occurs when you double-click a file is called its primary

action. Looking Glass lets you display all the possible actions for a

file and choose one. If you’re not sure what a file’s primary action

is, you should view the possible actions before activating it.

Choosing an action from the list of possible actions will have no

lasting effect—the primary action for the file will not be changed.

1. Control+double-click the file.

If there are no actions associated with the file, Looking Glass

displays a dialog telling you that.

If there are actions associated with the file, Looking Glass dis-

plays the Select A Command dialog:

Run prefered test editor

Page through file

Count file’s lines, words and characters

Command Line:

/ust/ucb/vi Zycor ; Ig_pause fi

Select A Command | Cancel HL_o«_]

The top part of the dialog contains descriptions of all of the

possible actions for the file. A description of the primary action

for the file is listed first and highlighted.

The bottom part of the dialog displays the command associated

with the highlighted action.

You may need to scroll through the list of actions to view all of

the commands.

2. Select an action to view the command associated with

it. (Don’t double-click an action unless you want to

execute it.)
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3. To choose the action you want:

e Double-click an action in the list

or

e Select an action from the list and click O K

The dialog closes and the file is activated with the selected

action.

Terminating jobs

When you run a program from Looking Glass, you will normally

exit it from within the program itself using the appropriate com-

mand. However, sometimes a program will “hang” or malfunction

so that you can’t terminate it normally. If this happens, Looking

Glass gives you a simple way to terminate the program.

NOTE:

Make sure that when you terminate a program, it’s really hung, not

simply waiting.

Job is a general term for a running program. There are two ways to

terminate most jobs launched from Looking Glass:

e The Request Job Termination command

e The Force Job Termination command

The Request Job Termination command sends a message to the job

asking it to stop. This command gives the program a chance to

clean up and exit. The Force Job Termination command forces the

job to terminate as soon as possible.

If you try to terminate a job with the Request Job Termination com-

mand and it does not stop, use the Force Job Termination com-

mand. If you have difficulty stopping a job with the Force Job

Termination command, see your system administrator.

1. In the Global window, select the icons for the jobs you

want to stop.

2. Choose Request Job Termination or Force Job

Termination from the Jobs menu in the Global

window.

The jobs are stopped and the icons are removed from the

Global window.

If a job refuses to terminate, a dialog is displayed telling you

that.
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Run in Terminal Window

Wl Pause After Execution

History: | compress #f
who | we -1

we -1#f







Displaying a terminal window

Looking Glass lets you use a command-line shell in a terminal emu-

lator window. Once you have displayed a terminal emulator win-

dow, you can enter shell commands to run programs, just as if you

were logged in at a character-based terminal. Looking Glass doesn’t

limit the number of terminal emulator windows you can have

open.

1. Choose Terminal Emulator from the Ran menu in any

Directory window or the Global window.

A terminal emulator window is displayed on your workspace.

If you display a terminal emulator window from a Directory

window, the current directory is the one displayed in the

Directory window.

If you display a terminal emulator window from the Global

window, the current directory is your home directory.

With the Execution Preferences command from the System menu,

you can specify both the terminal emulator program and your com-

mand-line shell.

For more information about specifying your default terminal emu-

lator program or a shell, refer to “Execution preferences” in Chapter

12, “Changing Looking Glass preferences.”



Organizing your workspace

In Chapter 1, “Getting started with Looking Glass,” we introduced the concept of the

Looking Glass workspace—a place to put the programs, files, and directories you use

most often. No two Looking Glass workspaces are exactly the same because each

reflects the work and preferences of an individual user. When you quit, Looking

Glass remembers how you left your workspace and restores it the next time you start

Looking Glass. We use the term Jayout to refer to the arrangement of your workspace,

including the size and location of any open Looking Glass windows and the contents

of the Desktop Panel.

Open and close the Desktop Panel

Put directories and files on the Desktop Panel

Remove directories and files from the Desktop Panel

View directories and files by their name or icon on the Desktop Panel









Working with the Desktop Panel

The Desktop Panel is a place to put icons for the directories and

files you use most often. The directories and files you put on the

panel are not removed from their actual location—they are just dis-

played there so you can access them easily.

You can open directories and files on the Desktop Panel the same

way you can in Directory windows. When you open a file from the

Desktop Panel, the application’s icon appears in the Global win-

dow. For more information about activating files, refer to Chapter

8, “Running programs.”

In this section, we tell you how to:

e Open and close the Desktop Panel

e Put directories and files on the Desktop Panel

e Remove directories and files from the Desktop Panel

e View directories and files by their name or icon on the Desktop

Panel

e View the full pathname of directories and files on the Desktop

Panel

e Open directories and files from the Desktop Panel

e Show directories and files on the Desktop Panel in Directory

windows



9-6 hb. Looking Glass User’s Guide

e Print files from the Desktop Panel

¢ Move directories and files around on the Desktop Panel

e Clean up the Desktop Panel

In addition to these actions, you can also move the Desktop Panel

to another position on the workspace and resize it. For information

about moving the Desktop Panel to another position on the work-

space and resizing it, refer to “Moving windows” and “Resizing win-

dows” in Chapter 2, “How you interact with Looking Glass.”

If a directory or file is dimmed on the Desktop Panel, it means that

Looking Glass cannot locate it.

Opening and closing the Desktop Panel

When you start Looking Glass for the first time, the Desktop Panel

opens on the right side of your screen. You can open and close the

Desktop Panel from the Show menu in the Global window. You can

also close the Desktop Panel from the File menu on the Desktop

Panel. The Desktop Panel check box in the Show menu is selected

or unselected, indicating whether or not the panel is displayed.

Opening or closing the Desktop Panel from the Global window

1. Choose Desktop Panel from the Show menu in the

Global window.

If the Desktop Panel was open, it closes.

If the panel was closed, it opens.

Closing the Desktop Panel from the Desktop Panel

i. Choose Close from the File menu on the Desktop Panel.

The Desktop Panel closes.
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Putting directories and files on the Desktop Panel

There are two ways to put any directory or file from a Directory

window on the Desktop Panel:

e Drag the directory or file to the Desktop Panel

e Use the Put On Desktop Panel command

Displaying a directory or file on the Desktop Panel by dragging

1. Drag the directory or file to the Desktop Panel.

The directory or file appears on the panel.

Displaying a directory or file on the Desktop Panel with the Put On

Desktop Panel command

1. Select the directory or file in a Directory window that

you want to put on the Desktop Panel.

2. Choose Pat On Desktop Panel from the File menu in

the Directory window.

The directory or file appears on the panel.

Removing directories and files from the Desktop Panel

1. Select the directory or file on the Desktop Panel you

want to remove.

2. Choose Take Off Desktop Panel from the File menu on

the Desktop Panel.

The directory or file no longer appears on the Desktop Panel.

Removing a directory or file using the Looking Glass Remove

command also removes the directory or file from the Desktop

Panel.

NOTE:

Directories and files that are dimmed on the Desktop Panel

can’t be located by Looking Glass. This usually occurs when a

directory or file has been moved or removed by a program

other than Looking Glass, or resides in a file system that is not

currently mounted or has been mounted at a different location.
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Viewing directories and files by name or icon

1. Choose Name or Icon from the View menu on the

Desktop Panel.

All of the directories and files on the Desktop Panel are dis-

played by name or icon.

Viewing the full pathname of directories and files

1. Choose Show Full Pathname from the View menu on

the Desktop Panel.

All of the directories and files on the Desktop Panel are dis-

played with their full pathnames.

NOTE:

If you move a file into a directory in a Directory window, the

file’s pathname changes in the Desktop Panel to reflect the new

directory.

Opening directories and files from the Desktop Panel

You can open directories and files on the Desktop Panel the same

way you can in Directory windows. The Open command opens a

Directory window for the directory you selected, or activates the file

you selected.

1. Select the directories and files on the Desktop Panel

you want to open.

2. To open the directories and files:

e Double-click each directory or file you want to open

or

e Choose Open from the File menu

If you selected a directory, it is displayed in a Directory window.

If you selected a file, it is activated.

Showing directories and files from the Desktop Panel

The. Show command displays a directory or file in a Directory window.
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1. Select the directory or file on the Desktop Panel you

want to show.

2. Choose Show from the File menu on the Desktop

Panel.

A Directory window opens with the directory or file selected.

Printing files from the Desktop Panel

1. Select the files on the Desktop Panel you want to

print.

2. Choose Print from the File menu on the Desktop

Panel.

Looking Glass prints the files. If you select a file that is not

printable, Looking Glass displays a dialog telling you that it will

not be printed. For more information about printing files, refer

to “Printing files” in Chapter 5, “Managing directories and

files.”

Moving directories and files around the Desktop Panel

1. Drag the directory or file to its new position on the

Desktop Panel.

The directory or file moves to its new position.

Cleaning up the Desktop Panel

You can clean up the Desktop Panel by using the Clean Up and

Clean Up Selection commands to neatly line up directories and

files.

Cleaning up the Desktop Panel with the Clean Up command

1. Choose Clean Up from the View menu on the Desktop

Panel.

All the directories and files are arranged in neat rows and

columns on an invisible grid, filling in the Desktop Panel from

left to right and top to bottom.
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Cleaning up the Desktop Panel with the Clean Up Selection command

1. Select the directories and files on the Desktop Panel

you want to clean up.

2. Choose Clean Up Selection from the View menu on the

Desktop Panel.

The directories and files you selected are moved to the nearest

available space on the grid—not necessarily filling in the

Desktop Panel from left to right and top to bottom.



Working with the Icon Editor
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Merging icon galleries

Looking Glass uses the contents of a single icon gallery, 1g_icons.d,

as its icon source. To maintain the integrity of the icons shared by

all Looking Glass users, this Main Gallery should be owned by the

super-user and protected from changes by other users. Users should

create or modify icons in galleries that they own. When users are

ready to put new or changed icons into the Main Gallery, the sys-

tem administrator can help them gain temporary access to the

Main Gallery or to a copy of the Main Gallery.

There are two ways to put new or changed icons into an icon

gallery:

e Use the Icon Editor’s copy and paste commands

e Use the icon_merge utility

For information on the first method, using the copy and paste com-

mands, refer to “Working with Gallery windows” earlier in this

chapter.

Using the icon_merge utility

The icon_merge utility merges one or more icon galleries into a sin-

gle gallery. The output file contains all uniquely named icons from

each of the input icon files, as well as any icons that were already in

the output file. If you are not experienced using operating system

utilities, ask your system administrator for assistance.

Here is the syntax of the icon_merge utility:

icon _ merge [-v] [-n] inputfile ... [-o outputfile]

The -v flag tells icon_merge to report on its status as it opens and

merges each icon file.
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The -n flag tells icon_merge to exit immediately if a duplicate icon

name is encountered. If this flag is not specified, icon_merge

retains the first icon with a given name and discards duplicates

without notification.

inputfile specifies the file or files that are to be merged. Any number

of files can be merged.

outputfile specifies the file into which the merged output is to be

placed. It can be an existing icon gallery. The -o flag must precede

any output file specification. If output file is not specified, the out-

put is placed in a file named icons.out.

The icon_merge utility issues appropriate exit codes. These codes

allow you to run the program from a shell script and take action

based on the outcome of the merge operation.
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The following table lists the exit codes issued by icon_merge:

Return code

All input files were successfully merged into

the output file, and the output file was suc-

cessfully written.

The command line used to invoke

icon_merge was incorrect.

The merge failed because of a duplicate icon

(the -n flag was given).

The merge failed because an input file could

not be read.

The output file could not be written. The

original version of the output file has been

restored.

The dialog manager could not be initialized.

You may need to set the value of your DIS-

PLAY environment variable.

icon merge failed as the result of an

unknown problem.







DISPLAY

HOME

PATH

SHELL

TERM

USER
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Changing Looking Glass

preferences

This chapter tells you how to set and change your Looking Glass preferences.

Preferences let you specify how you want Looking Glass to do certain things.

With the System menu in the Global window, you can:

e Use the Color Preferences command to change the color of all Looking Glass

user interface elements

e Use the Removal Preferences command to tell Looking Glass when to ask for

confirmation before you delete a directory or file

e Use the Execution Preferences command to specify which program to use for dis-

playing terminal emulator windows, which text and data editors to use, which
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Changing color preferences

Top shadow color

If you have a color monitor, you can change the colors of user

interface elements with the Color Preferences command from the

System menu in the Global window. If you don’t have a color mon-

itor, the Color Preferences command is dimmed.

With the Color Preferences command, you can change the color

used to display the following elements:

e Background

e Foreground

¢ Top shadow

e Bottom shadow

Background is the “canvas” that objects are drawn on. For example,

the workspace area behind directories and files displayed in

Looking Glass.

Foreground is what is drawn on the “canvas.” For example, text,

icons, buttons, and check boxes.

Top shadow is the shadow that appears on the top and left edges of

three-dimensional objects.

Bottom shadow is the shadow that appears on the bottom and right

edges of three-dimensional objects.

If you are using the two-dimensional look and feel, the top shadow

and bottom shadow elements are not used.

Here is an example of background, foreground, top shadow, and

bottom shadow elements:

Foreground color

rer Bottom shadow color

Background color

The following paragraphs give you some guidelines for setting your

color preferences.
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If you are using the two-dimensional look and feel for Looking

Glass, the foreground color should stand out well against the back-

ground color.

If you are using the three-dimensional look and feel for Looking

Glass, the top shadow color should be the lightest color. It is a good

idea to use a color similar to the background. For example, if you

set the background to a blue hue, the top shadow should have a

blue hue, but should be a much lighter shade. The bottom shadow

color should be the darkest color. It should also be similar to the

background, but should be a much darker shade. The foreground

color should stand out well against the background color.

There are three ways to specify colors in Looking Glass:

e The Name method, where you choose a color from a list

e The Hue, Saturation, Brightness (HSB) method, where you

adjust the hue, saturation, and brightness values to specify a

color

e The Red, Green, Blue (RGB) method, where you adjust the red,

green, and blue values to specify a color

HINT:

A fast way to choose a color is to use the Name method to pick the

basic color and then use the RGB or HSB option to adjust the color.

Accessing the Color Preferences dialog

1. Choose Color Preferences from the System menu in the

Global window.
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The Color Preferences dialog opens. This dialog displays the col-

ors that Looking Glass currently uses for the four user interface

elements:

3 amen

| Set background color... | | |

| Set foreground color... | [i

| Set top shadow color... | [i

|Set bottom shadow color...| [i

Change Systom Colors [ox _]

2. Select the button for the user interface element you

want to change or adjust.

The Name, HSB, or RGB or dialog is displayed:

aquamarine

Name dialog cr etenncesvesesseag posers black

cadet blue

comflower blue

Pick Background Color

The color readout box in the upper right corner of the dialog

shows the color currently used for the selected element. When

you adjust the color, the top half of this box changes to show

the new color; the bottom half displays the original color.

Use one of the three methods to change the color of the selected

element.

Using the Name method

1. Choose Name from the option menu (below the color

readout box).

A scrolling list of colors appears on the left side of the dialog.
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2. Select a color.

The top half of the color readout box changes to show the

selected color. You can return to the original color by clicking

the bottom half of the color readout box.

3. Click OK.

Using the HSB method

1. Choose HSB from the option menu (below the color

readout box).

2. To define the new color, drag the:

e Hue slide arrow to set the base color

® Saturation slide arrow to set the amount of the base color

displayed

® Brightness slide arrow to make the color lighter or darker

The top half of the color readout box displays the changes you

make. You can return the slider arrows to their original posi-

tions by clicking the bottom half of the color readout box.

3. Click OK.

Using the RGB method

1. Choose RGB from the option menu (below the color

readout box).

2. To define the new color, drag the:

® Red slide arrow to set the amount of red in the color

® Green slide arrow to set the amount of green in the color

® Blue slide arrow to set the amount of blue in the color

The top half of the color readout box displays the changes you

make. You can return the slider arrows to their original posi-

tions by clicking the bottom half of the color readout box.

3. Click OK.
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Changing removal preferences

Use the Removal Preferences command from the System menu in

the Global window to tell Looking Glass when to ask you for confir-

mation before removing directories and files.

There are two categories of removal options: one for files and one

for directories.

File Removal——"""""),_—sr” Directory Removal

HE confirm Single @ Confirm All

Confirm Multiple > Confirm Non-Empty
(] confirm Read-Only > Don’t Confirm

Set Removal Preferences | Cancel | OK J
aaa

1. Choose Removal Preferences from the System menu in

the Global window.

2. Select:

¢ Confirm Single if you want Looking Glass to ask you for

confirmation before it removes each file

° Confirm Multiple if you want Looking Glass to ask you for

confirmation before it removes more than one file

® Confirm Read-Only if you want Looking Glass to ask you

for confirmation before it removes files with read-only pro-

tection

¢ Confirm All if you want Looking Glass to ask you for con-

firmation before it removes each directory

® Confirm Non-Empty if you want Looking Glass to ask you

for confirmation before it removes each directory that con-

tains subdirectories or files

® Don’t Confirm if you never want Looking Glass to ask you

for confirmation before it removes a directory

3. Click OK.
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Changing execution preferences

Use the Execution Preferences command from the System menu in

the Global window to specify programs (along with any needed

arguments) that Looking Glass executes when you run certain

programs.

You can change the programs used for:

e A terminal emulator

e Editing a text file

e Editing a non-text (“data”) file

e Functions handled by an external shell

e Formatting and printing text files

When you select the Execution Preferences command from the

System menu in the Global window, the Execution Preferences

dialog is displayed:

Terminal Program: |SieEalaaieall |
Looking Glass Assigns Position

Text Editor:|/usr/ucb/vi #f ; Ig_pause |

Run in New Terminal Emulator Window i

Data Editor:| |

fie) a Naw Termaial Enwiator Window

Extemal Shell:|/bin/sh

Print Formatter:|/bin/pr #f ]

Print Spooler: //usr/ucb/Ipr |

=]

Set Execution Preferences | Cancel | IL OK J

Specifying a terminal emulator

The Terminal Program field in the Execution Preferences dialog

allows you to specify the pathname of the program you want

Looking Glass to execute when you select Terminal Emulator from

the Run menu, and when you use commands that must be run in a

terminal emulator.

You can also have Looking Glass determine the position of terminal

emulator windows on the workspace by selecting the Looking Glass

Assigns Position check box (below the Terminal Program field). If

the check box isn’t selected, the window manager determines the

position.



12-8 hh Looking Glass User’s Guide

To specify a terminal program:

1. Choose Execution Preferences from the System menu

in the Global window.

2. Edit the Terminal Program field.

Include any arguments you would use if you were invoking the

program from a shell command prompt.

3. Select the Looking Glass Assigns Position check box if

you want Looking Glass to determine the position of

the terminal emulator window.

If you want to determine the position of the window yourself,

make sure the check box is not selected.

4, Click OK.

Specifying text and data editors

The Text Editor and Data Editor fields in the Execution Preferences

dialog display the pathnames and arguments for the programs you

want Looking Glass to execute when you double-click a text or data

file.

If you want to change your text or data editor, make sure you know

the syntax used to invoke the program. If you enter just the path-

name of the editor, Looking Glass assumes it takes a filename as its

only argument.

For example:

If you enter:

/usr/bin/emacs

in this field, Looking Glass executes the command:

/usr/bin/emacs filename

when you double-click a text file (filename is the name of

the file you double-clicked).
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Some editors and word processors may require additional command-

line arguments to edit a file. They may also need to have the filename

in a specific position in the command line. If you want the editor

called with command-line arguments, or if you want to run a shell

script that runs your editor, you must insert the Looking Glass special

symbol for selected files (#£) in the appropriate place in the com-

mand line.

For example:

If all of your text files are encrypted, you may want to use the

editor vi with the -x argument. (This argument allows you

to edit encrypted files.) In this case you would enter:

/asr/bin/vi -x #f

This causes Looking Glass to execute the vi editor with the -x argu-

ment. When you open a text file, its name is inserted where the #£

sign appears in the command line.

If the text or data editor you use does not create its own window, it

must be run in a new terminal emulator window. If you tell

Looking Glass to run your editor in a terminal emulator window,

we also recommend that you put the 1g pause command after the

command that calls the editor (see the example below).

To tell Looking Glass to run your editor in a new terminal emulator

window, select the Run In New Terminal Emulator Window check

box, which is immediately below the Text Editor or Data Editor

field in the Execution Preferences dialog.

If you want to read any exit messages from your editor or other pro-

gram before its window disappears, put the 1g pause command

after the command that calls the editor. The 1g pause command

provided with Looking Glass prompts you to press the Return key

before exiting the terminal emulator window. When you use

lg pause, you must specify the position of the filename in the

command line using the Looking Glass special symbol for selected

files (#f£).

For example:

To use the editor vi as your text editor, select the Run in

New Terminal Emulator Window check box and enter the

following in the Text Editor field:

/usxr/bin/vi #f£ ; lg _pause

Note the use of the semicolon between the command that runs the

editor and 1g pause; this causes 1g_pause to run after the editor

has exited.
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To run a shell script that runs your editor, enter the full pathname

of your shell, the full pathname of the shell script it will execute,

and #£.

For example:

/ein/sh /usr/hal/edscript #f

To specify a text or data editor:

1. Choose Execution Preferences from the System menu

in the Global window.

2. Edit either the Text Editor or Data Editor field.

Include any necessary programs and arguments.

If the editor you specify does not create its own window, select

the Run In New Terminal Emulator Window check box (below

the Text Editor or Data Editor fields).

3. Click OK.

Specifying an external shell

The External Shell field in the Execution Preferences dialog displays

the pathname of the shell Looking Glass uses for any operation that

requires an external shell, for many double-click actions, and for

the Terminal Emulator command from the Run menu in the Global

window.

If you want to change the shell, enter the full pathname of the shell

in the External Shell field. We recommend that you use the Bourne

Shell (sh), the C Shell (csh), or the Korn Shell (ksh).

1. Choose Execution Preferences from the System menu

in the Global window.

2. Edit the External Shell field.

3. Click OK.
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Specifying commands for printing

When Looking Glass prints a file, it uses two commands: one to for-

mat the file and one to spool it to the printer. These two commands

are displayed in the Print Formatter and Print Spooler fields in the

Execution Preferences dialog.

The formatter command processes the file for printing—it may pag-

inate the document or put in headers. The spooler command

receives the data produced by the formatter command and sends it

to the printer.

When you select the Print command from the File menu, Looking

Glass checks to see if a special formatter command is defined for

that type of file. If there is one, Looking Glass uses it. If there is no

special command, Looking Glass uses the command specified by

your execution preferences. For more information about file types,

refer to Chapter 13, “Defining file types.”

The output of the formatter command is then sent to the spooler

command specified by your execution preferences.

To determine the correct values for the Print Formatter and Print

Spooler fields, take the full command string you would normally

use to print files and split it at the pipe symbol. Put the first half of

the command in the Print Formatter field. Looking Glass assumes

that the filenames of the files to be printed are inserted at the end

of the print command. If the filenames belong somewhere other

than the end of the command, you need to insert the special sym-

bol for selected files (#£) where the filename should be placed. Put

the second half of the command in the Print Spooler field.

Looking Glass supplies the pipe symbol at execution time.

For example:

If you would normally print a file by entering on the com-

mand line:

pr filename | lp

you enter:

prorpr #£ in the Print Formatter Field and Ip in the Print

Spooler field.

To specify print commands:

1. Choose Execution Preferences from the System menu

in the Global window.
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2. Edit the Print Formatter and Print Spooler fields.
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Creation Mask

Rw <x woo |
@ Store Mask

1 0) 0 owner

O00 Group

joo Others

”

© inherit Mask

Directory Acce

R WX 750

Mi owner

Wi Cc) HE Group
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4”

Set Cleanup Preferences | Revert | | Cancel ] [ex |
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- Directory Window Titles

Hi include Host Name BE inciude Full Pathname

* in, Leave As Is
© Fit To Files

© Fit To Directories

= positionabe DI Show Hidden |

Set Display Preferences [ence] [Lox]
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Defining file types

In this chapter you'll learn:

e How file typing works

e The general capabilities of the File Typing Language

e How to define, compile, and install file typing rules
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How file typing works

Looking Glass’s file typing mechanism consists of three basic

components:

e A File Typing Language (FTL), which is used to define the rules

by which file types are identified

e A File Typing Compiler (FTC), which compiles file typing rules

written using the FTL

e A File System Server (FSS), which manages file system informa-

tion and allows high-speed access to directories of any size

File type definitions are written in text files using the File Typing

Language. They include statements that describe files, such as a par-

ticular format for a filename, a string of characters that must be

found in a particular location in the file, or a location in the file

system in which the directory or file must be found. In addition to

the rules used to determine file types, file type definitions specify

the icon to display for each directory or file and any actions associ-

ated with that type of file. These definitions are compiled by the

File Typing Compiler to create a binary file named LG_rulebase.

LG _rulebase is stored in the Looking Glass data directory (specified

at installation) and is read into memory at startup.

As an optional step in the installation of Looking Glass, each direc-

tory and file is examined to determine its type. A small database file

named .1gdb is placed in each directory examined with file typing

information for each directory and file in the directory. When

Looking Glass displays the contents of a directory, the File System

Server looks for a .1gdb file. If the file isn’t found, the directory is

typed. If the user has write permission for the directory, a .1gdb file

is created for use the next time a Looking Glass user opens the

directory. If a .1gdb file is present, the File System Server compares

the contents of the .1gdb file to the contents of the directory to

determine whether any directories or files were added to the direc-

tory since the last time the .1gdb file was modified. If so, any newly

added items are typed according to the current rulebase. If the cur-

rent user has write permission for the .1gdb file (the normal situa-

tion), it is updated.
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Overview of the File Typing Language

The following syntax diagram shows the general format of a

file type definition:

DEFINE [TYPE | DIRECTORY] <type name>

ICON <icon name>

FILE DESCRIPTION | <text>

<rule statement>

<command section>

END

Each file type definition must include at least the following |
components:

e A DEFINE TYPE or DEFINE DIRECTORY statement

e An ICON statement

e A rule statement

e An END statement

The DEFINE TYPE or DEFINE DIRECTORY statement signals

the beginning of a file type definition.

The ICON statement assigns a specific icon to the file type.

The icon you assign represents the file type when viewed by

icon in Looking Glass.

The rule statement describes how to recognize the file type

based on a file’s name and content.

Each definition may also have a command section. The com-

mand section provides a list of shell commands that are

available to the user as double-click actions, as well as any

special information about printing files of this type. If the

command section is left out of a definition for a file, Looking

Glass users who attempt to print or open a file of this file

type are warned that the operation can’t be completed.

The END statement signals the end of a file type definition.
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While the components of a file type definition are very strictly

defined, the format of the file typing source code is not. For exam-

ple, from the compiler’s point of view, the following two defini-

tions are identical even though they are formatted differently:

Example 1:

DEFINE TYPE EmptyFile

ICON EMPTY FILE ICON
EMPTY

COMMAND : TEXT_ EDITOR

END

Example 2:

DEFINE

TYPE EmptyFile

EMPTY

COMMAND :

TEXT_EDITOR

ICON

EMPTY FILE ICON

END

Building file type definitions

This section describes the process of building file type definitions

for a file typing rulebase. The order in which the the various steps

are performed is not critical; however, if you have never created or

modified file type definitions before, we suggest that you perform

the steps in the order presented here.

All of the keywords mentioned in this section are described in more

detail in the “File Typing Language reference” section later in this

chapter.

Selecting a source file for new file type definitions

Before creating a new file type definition, you need to select a

source file to store the definition in. Five empty source files are pro-

vided with Looking Glass. These source files are normally stored in

the directory /usr/lib/lg/lg_ftc. Each of the source files is

intended for a specific category of file type definitions.
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The following table lists the categories of definitions that you

should put in each source file:

Store the file type definitions of: In this source file:

Specific binary executable files prog.loc.ftc

Specific types of data files data.loc.ftc

Device files dev.loc.ftec

General file types, such as text or empty files gen.loc.fte

Low-level file type classes such as shell scripts class.loc.fte

and devices

It is important to put file type definitions in the appropriate source

files to ensure accurate file typing. The source files are compiled in a

specific order so that the more specific definitions (those in

prog. loc.ftc) are put at the head of Looking Glass’s rulebase, and

the most general (such as those in class.loc.ftc) are put at the end.

When you have selected the appropriate file for the file type defini-

tion you are creating, you are ready to edit the file and begin creat-

ing a file type definition.

Assigning a name to a file type definition

Each file type definition must begin with a DEFINE TYPE or DEFINE

DIRECTORY keyword that assigns a unique symbolic name to the

file type definition.

For example:

DEFINE TYPE SpreadSheet

This statement signals the beginning of a definition for a file type

called SpreadSheet.
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Assigning an icon to a file type definition

Each file type definition must have an icon assigned to it using the

ICON keyword. The assigned icon represents the file type when

viewed by icon in Looking Glass. Icon names are created in the

Icon Editor. For more information about the Icon Editor, refer to

Chapter 10, “Working with the Icon Editor.”

The following statement identifies the icon SPREADSHEET_DOC to

be displayed for files that match this file type definition:

ICON SPREADSHEET DOC

If you assign an icon that doesn’t exist, Looking Glass displays the

generic document icon shown on the left.

Building file matching rules

The rule statement of a file type definition tells Looking Glass how

to identify the file type. It is made up of some combination of

NAME, DIRECTORY, and CONTENT statements, and intrinsic key-

words. Intrinsic keywords identify file types that are recognized by

Looking Glass without information specified in NAME, DIREC-

TORY, and CONTENT statements.

These are the intrinsic keywords that Looking Glass recognizes:

e EMPTY

e TEXT

e BINARY_EXECUTABLE

e BLOCK_DEVICE

e CHARACTER_DEVICE

e FIFO

e SOCKET

e SYMBOLIC_LINK

The following examples demonstrate the use of these components

in constructing rules. For a detailed description of any statement,

refer to the “File Typing Language reference” section later in this

chapter.

Any rule component can be used by itself. For example, the follow-

ing file type definition matches any text file:

DEFINE TYPE TextType

ICON ASCII TEXT

TEXT

END
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Rule components can also be combined with the AND and OR

operators, as in this example of a file type definition for C program-

ming language source files:

DEFINE TYPE CSourceType

ICON C SOURCE ICON
TEXT AND NAME "*.c"

END

The AND in this definition’s rule means that a matching file must

satisfy both conditions: it must hold text, AND the last two charac-

ters of its name must be “.c”. (If the AND were replaced with OR,

the definition would match files that satisfied either condition; that

is, all files that contain text or end in “.c”.)

The order in which file type definitions are presented is very impor-

tant. In general, definitions should be organized so that the defini-

tions with the more specific rules are put at the top of the source

file, and the definitions with most general rules are put at the end.

Remember that a file is compared to the rules of a definition until

the first match is found. If the two preceding examples were defined

in the order presented above (TextType first, CSourceType second),

all C source files would mistakenly be classified as TextType files

because the TextType definition would be matched first. If the order

of the definitions were reversed, the rules would work as intended.

Text files that failed to match the more stringent rules in CSourceType

would “fall through” and match the TextType definition. Type defini-

tions as general as the TextType example are useful, but they must

be placed near the end of the rulebase so that they don’t prevent

files from matching more specific definitions.

The remaining major rule components are the CONTENT and

DIRECTORY statements. Consider the following example:

DEFINE TYPE ManDocType

ICON UNIX_MAN DOC

FILE DESCRIPTION

"Unformatted manual page"

TEXT AND DIRECTORY "*/man*" AND CONTENT 0 TO

2000 STRING "\n.TH " OR

TEXT AND DIRECTORY "*/man*" AND CONTENT O TO

2000 STRING "\n.so "

END

This rule specifies that any files located in a directory whose name

starts with “man” and that contain lines starting with “.TH ” or

“.so” in their first 2,000 characters are unformatted manual pages.
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Organizing rules for maximum efficiency

Improperly organized rules can seriously degrade Looking Glass’s
performance. Keep these points in mind when deciding on the
order of rules in the rule section of a file type definition:

e Intrinsic components are processed faster than NAME and
DIRECTORY statements

¢ NAME and DIRECTORY statements are processed much faster
than CONTENT statements

¢ Rule components are evaluated in the order they are presented
in the file type definitions

Wherever a series of rule components are to be joined by OR or
AND, try to put the fastest components first.

For example:

DIRECTORY "*/man*" AND CONTENT 0 TO 2000 STRING
"\n ~3SO Ty

is faster than:

CONTENT 0 TO 2000 STRING "\n.so " AND DIRECTORY
"* /man* rT)

because Looking Glass only needs to examine files in directories
whose names match the “*/man*” expression.

Building the command section

The command section of a file type definition defines the actions
that associated with a file type and, in some cases, how to print it.
Since directories cannot be assigned actions, this section is left out
of type definitions for directories.

Actions are specified with the COMMAND statement.

Here is our CSource example extended to include several actions:

DEFINE TYPE CSourceType

ICON C_SOURCE_ICON
TEXT AND NAME *.c

COMMAND: TEXT EDITOR
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COMMAND "echo Lines, words, and characters of #f

3; we #f£"

COMMAND DESCRIPTION

"Count file's lines, words, and characters"

COMMAND "make ‘basename #f .c*.o"

COMMAND DESCRIPTION

"Generate object file with Make"

END

Each COMMAND statement specifies a different command that a

user can invoke for a matching file. The #£ symbol used in several

of the commands is replaced at runtime with the name of the file

that matched this file type definition.

When a user double-clicks the icon for this file, the first command

in the definition is invoked. In our example, the first command

invokes the user’s default text editor, specified as part of the user’s

Looking Glass execution preferences.

If the user Control+double-clicks the icon for this file, a dialog is

displayed listing all of the commands that can be used with a file.

In the example above, the following three commands would be

displayed:

e The command that invokes the text editor

e A command that counts the file’s lines, words, and characters

e Acommand that generates an object file

When the user chooses a command from this list, the command is

invoked (it is passed to the user’s external shell).

The command section also contains any special instructions for

printing the file type. Printing in Looking Glass is done in a two-

step process using external programs: first the file is formatted, then

the file is sent to a spooler for printing. The programs used by the

Looking Glass Print command are specified in the user’s execution

preferences.

To specify that a file type is printable and should be printed by this

“default” method, include the ATTRIBUTE : PRINTABLE statement

in the file type definition. If you don’t include this statement,

Looking Glass will not print this file type. For more information

about printing, refer to “Printing files” in Chapter 5, “Managing

directories and files.”
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Some types of files require special treatment before printing. To

specify a custom print formatting command for a file type, use the

COMMAND : PRINT statement. In the following example, the

COMMAND : PRINT statement is used to specify custom formatting

for files that contain the operating system manual:

DEFINE TYPE ManDocType

ICON UNIX MAN DOC

FILE DESCRIPTION

"Unformatted manual page"

TEXT AND DIRECTORY "*/man*" AND CONTENT 0 TO

2000 STRING "\n.TH " OR

TEXT AND DIRECTORY "*/man*" AND CONTENT 0 TO

2000 STRING "\n.so "

COMMAND : TEXT EDITOR

COMMAND : PRINT

"nroff -man #f "

END

Manual pages are stored in the troff formatting language. The COM-

MAND : PRINT statement tells Looking Glass to replace the user’s

default formatting command with the nroff -man #£ command for

files of this type. The output of the formatting commani4d is still sent

to the print spooler specified in the user’s execution preferences.

Because the ATTRIBUTE : PRINTABLE statement specifies printing

in accordance with the user’s print formatter preference and the

COMMAND : PRINT statement specifies special formatting for the

file type, these two statements cannot be used in the same file type

definition.

Specifying the rule’s FEATURE_SET

Looking Glass has the ability to ignore or use file type definitions

based on the value of the environment variable LG_FEATURE_SET.

Looking Glass reads the value of LG_FEATURE_SET at startup time

to determine if certain file typing rules should be used. This allows

you to create file type definitions that can be turned on or off on a

per-user basis You should use this capability to test new file type

definitions in a restricted environment before you make them gen-

erally available.

Including the following statement in a file type definition causes

Looking Glass to ignore it unless the user’s LG_FEATURE_SET envi-

ronment variable is set to “TEST”:

FEATURE SET TEST
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Before testing the rule, set your own LG_FEATURE_SET environ-

ment variable to “TEST,” save your environment variables, and

restart Looking Glass.

After you have tested the rule, return your LG_FEATURE_SET envi-

ronment variable to its usual value (or delete it) and restart Looking

Glass. To make the rule available to other users, remove or change

the FEATURE_SET statement in the FTL source file and then recom-

pile the rulebase. (Refer to the description of the FEATURE_SET key-

word in the “File Typing Keyword reference” section later in this

chapter.)

Ending a file type definition

End a file type definition with the END keyword.

Generating the Looking Glass rulebase

The FTC directory that stores source files also contains a file named

Makefile, which is used by the make programmer’s facility when it

generates a new rulebase.

To create anew LG rulebase file:

1. Make sure you are in the FTC directory (normally

/ausr/lib/lg/lg_ftc).

2. Type make all at the command line.

The make program generates a series of commands to create a

new LG rulebase file. When the make program has finished,

the rulebase is ready for installation.

Installing the Looking Glass rulebase

You are now ready to install a new Looking Glass rulebase contain-

ing any additions or changes you have made to the file typing

source files.

The FTC directory contains two files named icons.sym and

records.sym. These files are very important and should never be

removed.
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The icons. sym file is maintained by the FTC; it stores the informa-

tion that tells Looking Glass what icon to display for a file. A copy

of icons. sym must be installed with the LG_rulebase file.

The records.sym file stores the names of the various file type

definitions (as specified in the DEFINE statement of each file type

definition).

The icons.sym and records. sym files are maintained separately

from the LG _rulebase files to accommodate networks with differ-

ent types of computers that may share a common file system. To

accommodate different operating environments, some machines

may need their own LG rulebase files based on a different set of

file typing source files. To ensure that typing information stored in

a directory’s .1gdb database file by one machine can be used by

another, the rulebase for each machine must be compiled in the

presence of the same icons. sym and records. sym files.

To install icons.sym and LG rulebase:

1. Make sure you are in the FTC directory (normally

/usr/lib/1g/l1g_ftc).

2. Type make install at the command line.

This invokes the make utility to copy LG_rulebase and

icons.sym to Looking Glass’s data directory.

Restarting Looking Glass

If you install a new set of file typing rules while Looking Glass is

running, you must quit and restart Looking Glass so that the new

LG rulebase file is read. Refer to Chapter 1, “Getting started with

Looking Glass” for instructions on quitting and starting Looking

Glass.

As a final consideration, you should note that it may be necessary

to use the Looking Glass Retype Directory command to receive

accurate file typing of directories that contain files or directories

affected by changes to the rulebase. For more information on the

Retype Directory command, refer to “Retyping a Directory” in

Chapter 4, “Working with Directory windows.”
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File Typing Language reference

This section provides detailed descriptions of all the components of

the FTL. The following subjects are included:

e File Typing Language statements

e Typing rule statements

e Parsing and syntax guidelines

e File Typing Language syntax summary

¢ File Typing Compiler command-line arguments

File Typing Language statements

This section contains descriptions of the following keywords:

e APPEND_COMMANDS

e APPEND_RULES

e ATTRIBUTE : HIDDEN

e ATTRIBUTE : PRINTABLE

e COMMAND

¢ COMMAND : PRINT

¢ COMMAND : TEXT EDITOR and COMMAND : DATA EDITOR

e DEFINE DIRECTORY

e DEFINE TYPE

e END

e FEATURE_SET

© FILE_DESCRIPTION

e ICON

e INHERIT_COMMANDS

e REDEFINE DIRECTORY

e REDEFINE TYPE

Keywords are described in alphabetical order for easy reference. For

each keyword, we provide a description of its purpose, a syntax dia-

gram (if applicable), and additional usage information.

APPEND_COMMANDS

APPEND COMMANDS {HEAD | TAIL} Name Commands END

Use the APPEND_COMMANDS statement to add new commands to

an existing file type definition.

Name identifies the type definition to which the commands that

are defined will be attached.
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Commands is one or more new commands that will be added to the

list of commands for the file type.

Either the HEAD or TAIL keyword must be used. Use HEAD to add

the defined commands to the beginning of the type definition’s

command list. If you use HEAD, the first command defined after

the APPEND_COMMANDS statement will become the default dou-

ble-click action for the file type. Use TAIL to add the defined com-

mands to the end of the type definition’s command list.

The APPEND_COMMANDS statement is most often used for

installing application programs that require typing modifications

and installing updates to Looking Glass. It allows the compiler to

modify an existing rulebase without modifying and recompiling

source code. The compiler will issue an error message and exit if the

type definition referenced by Name hasn’t been defined.

APPEND_RULES

APPEND_RULES Name Rules END

Use the APPEND_RULES statement to append new rule components

to an existing file type definition.

Name identifies the type definition to which the rules that are

defined will be attached.

Rules is one or more new rules that will be effectively joined to the

original with the OR keyword. For descriptions of the available

statements, refer to “Typing rule statements,” later in this chapter.

The APPEND_RULES statement is most often used for installing

application programs that require typing modifications and instal-

lation of updates to Looking Glass. It allows the compiler to modify

an existing rulebase without modifying and recompiling source

code. The compiler will issue an error message and exit if the type

definition referenced by Name hasn’t been defined.

ATTRIBUTE : HIDDEN

Use the ATTRIBUTE : HIDDEN statement to tell Looking Glass that

the file or directory type being defined is hidden. Users won’t see

files or directories of this type in Locking Glass Directory windows

unless they explicitly choose to view hidden files.
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ATTRIBUTE : PRINTABLE

Use the ATTRIBUTE : PRINTABLE statement to tell Looking Glass

that the file type being defined can be printed with the default

print formatting command (as defined in the user’s execution pref-

erences). This statement can’t be used with any file type definition

that uses the COMMAND : PRINT statement.

If the ATTRIBUTE : PRINTABLE statement is not specified for a file

type definition, and if no print command is specified, Looking

Glass won't print files that match this type.

COMMAND

COMMAND [ATTRIBUTE : Attribute] "CommandSt ring"

[COMMAND DESCRIPTION "CommandDescription"]

Use the COMMAND statement to define the commands that will be

associated with a file type.

Any number of COMMAND statements can be included in a file

type definition. The first command specified is the default double-

click action that is assigned to the file. Any other commands you

include in the file type definition can be viewed and selected in a

dialog that is displayed when the user Control+double-clicks a file.

CommandsString is the text of a shell command, enclosed in single or

double quotes, that is executed when the user double-clicks on the

file. The command string can provide a full pathname to an exe-

cutable program, but this is not a requirement. (Looking Glass fol-

lows the user’s search path—as specified in the PATH environment

variable—-to locate the program if a full pathname is not given.)

Environment variables are allowed in the command String. Shell

scripts can also be used, but should be preceded by the shell exe-

cutable to make sure the correct shell executes the script. (If the

shell is not specified explicitly, Looking Glass uses the shell speci-

fied in the user’s execution preferences.)

For example:

COMMAND "/bin/sh SHOME/bin/myshellscript #f"

The filename the user double-clicked is placed wherever the #£ spe-

cial symbol appears. To make the file run as a result of a double-click

(for example, to run the Bourne Shell as a result of double-clicking

on /bin/sh), the first argument in the COMMAND statement

should be ./#f£. The “/” is necessary to ensure proper execution if

the file is in a directory that is not included in the user’s search path.

The special Looking Glass symbols #u, #g, and #c are also available,
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for the user’s name, the group name, and the current directory,

respectively.

The optional COMMAND_DESCRIPTION statement describes an

entry in the list of commands generated by a Control+double-click.

It’s a good idea to keep command descriptions concise.

CommandDescription is a description of the command, enclosed in

double quotes ("), that appears when the user holds down the

Control key and double-clicks a file.

Attribute is a statement that gives Looking Glass more information

about how the command should be run. With each command

statement, you can include one (and only one) of the following

attribute statements:

This attribute: Does this:

NATIVE Tells Looking Glass that the command to be exe-

cuted will run as a native window system applica-

tion, and does not need a terminal emulator

window

TTY Tells Looking Glass that the command needs a

scrolling tty window, and does not need a termi-

nal emulator window

(Many operating system utilities that print status

information, such as ps and who, fit into this cate-

gory.)

TERMINAL_WINDOW _ Tells Looking Glass that the command needs a

full-featured terminal emulator window (one that

supports features such as cursor addressing)

Full-screen editors like vi need this type of win-

dow. This is the default.

SINGLE_ARGUMENT Tells Looking Glass that this particular command

can only take one file at a time as an argument

This attribute is used when the Open command

from the Looking Glass File menu is selected to

open several files of the same type. If SINGLE_

ARGUMENT is specified, Looking Glass will exe-

cute the command for that type selected. By

default, Looking Glass will open all files of the

same type with a single command.
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COMMAND : PRINT

COMMAND : PRINT [ATTRIBUTE : SINGLE ARGUMENT}

"CommandText" [COMMAND DESCRIPTION "Description" ]

Use the COMMAND : PRINT statement to specify a special print for-

matter for files that match the file type. The special print formatter

replaces the user’s preferred print formatter when a file that matches

the file type is printed. If no print command is specified, and if no

ATTRIBUTE : PRINTABLE statement is specified for the file type def-

inition, Looking Glass won’t print files that match this type.

CommandText is the text of the print formatting command that is

used when the file type is printed.

Description is the description that will be associated with the print

command in the Select A Command dialog (displayed when user

Control+double-clicks a file).

COMMAND : TEXT_EDITOR

and

COMMAND : DATA_EDITOR

COMMAND : { TEXT EDITOR | DATA_EDITOR }

The COMMAND : TEXT_EDITOR and COMMAND : DATA_EDITOR

statements cause Looking Glass to insert the user’s default text and

data editors into the list of possible commands for files that match

this type. (The pathnames and arguments for these executable pro-

grams are specified in the user’s execution preferences.)

DEFINE DIRECTORY

DEFINE DIRECTORY Name ICON IconName {OPEN ICON

OpenIconName) [FILE_DESCRIPTION Description] DIRECTORY

DirectoryName [DirectoryName...] [FEATURE_SET FeatureName

{[FeatureName...]] END

Use the DEFINE DIRECTORY statement to assign one or more icons

to a directory type. (Use the DEFINE TYPE statement, described

below, to begin a file type definition.) The DEFINE DIRECTORY

statement actually comprises a series of keyword clauses that make

up a complete directory type definition. No commands can be asso-

ciated with a directory type.

Name is the unique symbolic name for the directory type definition.
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IconName is the name of the icon to be displayed for this directory

type.

Use the optional OPEN_ICON keyword to specify a separate icon for

the directory when it is open in a user’s Looking Glass workspace.

OpenIconName is the name of the icon used to represent the open

directory. If the OPEN_ICON keyword is not used, Looking Glass

will display the icon specified in IconName.

Use the optional FILE_DESCRIPTION keyword to provide a descrip-

tion of the directory type. Description is a description of the direc-

tory type that appears in the Type field when directories and files

are displayed in Wide view in Looking Glass Directory windows and

in the Information dialog. It is advisable to keep this description

concise.

The DIRECTORY keyword defines the names of directories that

match the directory type. DirectoryName is a string that is compared

to the full pathname of the directory. It is usually a good idea to

precede a full pathname with the “match all” character (*), because

network file systems often include a mount directory that precedes

the target. For example, */usr/bin would match /usr/bin, as well

as /machineA/usr/bin.

The FEATURE_SET keyword restricts use of a directory type defini-

tion to specific environments (such as specific user groups or oper-

ating systems). FeatureName specifies a series of one or more feature

symbols. If a directory type is defined with one or more feature

symbols, and none of the symbols are set in the running version of

Looking Glass, the directory type is disabled (no directories will

match it). For more information, refer to the general description of

the FEATURE_SET statement below.

The END keyword signals the end of a directory type definition.

DEFINE TYPE

DEFINE TYPE Name

Use the DEFINE TYPE statement to begin a new file type definition.

The DEFINE TYPE statement must be the first component of a file

type definition. (Use the DEFINE DIRECTORY statement, described

above, to begin a directory type definition.)

Name is the unique symbolic name for the file type definition. The

compiler will not allow duplicate names.
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END

END

The END statement indicates the end of a file type definition.

FEATURE_SET

FEATURE SET Name [Nanre ...]

Use the FEATURE_SET statement to restrict use of a file type defini-

tion to specific environments (such as specific user groups or oper-

ating systems).

Name is a series of one or more feature symbols. If a file type is

defined with one or more feature symbols, and none of the symbols

are set in the running version of Looking Glass, the file type is dis-

abled (no files will match it).

There are two ways to set feature symbols in Looking Glass:

e Certain feature symbols are intrinsically set in specific versions

of Looking Glass to accommodate variations between hardware

platforms and operating systems

e The value of the LG_FEATURE_SET environment variable is

read during Looking Glass startup

If one or more of the feature symbols is set (either intrinsically or

with the LG_FEATURE_SET environment variable), directories or

files that meet the other criteria in the file type definition will

match the file type. When no feature symbols are included in a file

type definition, the file type is recognized in all environments.

For a list of the feature symbols that are set intrinsically for your ver-

sion of Looking Glass, refer to the Looking Glass Installation Guide.

FILE_DESCRIPTION

FILE DESCRIPTION "Description"

Use the FILE_DESCRIPTION statement to create a text description

of the type of file that will be identified by this record.
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Description is the information that appears in the Type field when

directories and files are displayed in Wide format in Looking Glass

Directory windows and in the Information dialog. You should keep

this description concise.

ICON

ICON Name

Use the ICON statement to assign an icon to a file type.

Name is the icon’s symbolic name defined in the Looking Glass

Icon Editor.

You can use the same ICON statement for more than one file type

definition. For example, you may want to use the cartridge tape

icon for more than one type of cartridge tape drive device file but

vary other parts of the file type definitions.

INHERIT_COMMANDS

INHERIT COMMANDS Name [Nane ...]

Use the INHERIT_COMMANDS statement to add the commands

assigned to other file types to the file type definition currently

being defined.

Name is the unique symbolic name (or names) of the file types you

want to inherit commands from (these are referred to as parents).

Any command lists inherited from parents are added to the end of

the current definition’s command list.

Any COMMAND: PRINT or ATTRIBUTE : PRINTABLE statements

that you put in the current definition override those inherited from

parents. If you don’t put these statements in the current definition,

the print command or ATTRIBUTE : PRINTABLE statement is inher-

ited from the first parent that has one of them in its file type

definition.

Inheritance is performed by Looking Glass at the time the file is

activated or when the possible actions for the file are displayed.
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REDEFINE DIRECTORY

REDEFINE DIRECTORY Name [ICON IconName] [OPEN_ICON

OpenIconName] [FILE_DESCRIPTION Description] [DIRECTORY

DirectoryName [DirectoryName ...]] [FEATURE _SET

FeatureName (FeatureName ...]] END

Use the REDEFINE DIRECTORY statement to replace any or all of

the components of an existing directory type record. Name is a sym-

bolic directory type name that must already be defined. See the

description of the DEFINE DIRECTORY statement, above, for

descriptions of all of the other keyword clauses. Any item that fol-

lows REDEFINE DIRECTORY will replace the corresponding item in

the referenced directory definition.

The REDEFINE DIRECTORY statement is most often used for instal-

lation of application programs that require file typing modifications

and installation of updates to Looking Glass. It allows the compiler

to modify an existing rulebase without modifying and recompiling

source code.

REDEFINE TYPE

REDEFINE TYPE Name [ATTRIBUTE : HIDDEN] [ATTRIBUTE :

PRINTABLE] [COMMAND CommandStatement [CommandStatement

---}]}] [COMMAND : PRINT PrintStatement] [COMMAND :

{TEXT EDITOR | DATA_EDITOR}] [FEATURE SET FeatureName

[FeatureName ...]] [FILE_DESCRIPTION "Description"] [ICON

IconName] [INHERIT COMMANDS Name [Name ...]] END

Use the REDEFINE TYPE statement to replace any or all of the com-

ponents of an existing file type record. Name is a symbolic file type

name that must already be defined.

Any item that follows a REDEFINE TYPE statement will replace the

corresponding item in the referenced file type definition. This

includes rule definitions and command definitions. (See

APPEND_RULES and APPEND_COMMANDS, above, for an explana-

tion of how to add rules and commands to existing file type records

without changing the current lists.)

The REDEFINE TYPE statement is most often used for installation of

application programs that require file typing modifications, and

installation of updates to Looking Glass. It allows the compiler to

modify an existing rulebase without modifying and recompiling

source code.
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Typing rule statements

Typing rule statements are single- or multipart statements that dis-

tinguish one file type definition from another. They are used to

determine if a file matches the file type definition.

This section contains a general discussion of the technique for

building typing rule statements, followed by a detailed description

of the following statements:

e BINARY_DATA*

e BINARY_EXECUTABLE*

e BLOCK_DEVICE*

¢ CHARACTER_DEVICE*

e CONTENT

e DIRECTORY

e EMPTY*

e FIFO*

e NAME

e TEXT”

¢ SOCKET*

e SYMBOLIC_LINK*

The statements in this list marked with an asterisk are intrinsic typ-

ing rule statements. Intrinsic statements let you match file charac-

teristics that are typed intrinsically by Looking Glass. These rules

are often used with NAME, DIRECTORY, and CONTENT rules to

narrow the search for file types.

Any typing rule statement can be used by itself to create a file-

matching rule, or it can be combined with another statement to

create a rule.

The typing rule statement in a file type definition is made up of

some combination of NAME, DIRECTORY, and CONTENT state-

ments and the intrinsic typing rule statements.
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You can use the following operators to connect typing rule

statements:

This

operator: Does this: Use it:

NOT Reverses the meaning of any statement Before a statement

AND Connects any statements to indicate Between statements

that both (or all connecting) statements

must be matched to match the file type

OR Connects statements to indicate that Between statements

either the previous statement or the next

statement must be matched to match

the file type

With these operators, you can combine file typing statements to

create rules that will match files with unique or special characteris-

tics in your system. Combining statements with operators also

helps Looking Glass to weed out the files that won’t match a file

type more efficiently.

The following example shows a file typing statement that combines

a TEXT and a NAME statement:

DEFINE TYPE CSourceType

ICON C SOURCE ICON

TEXT AND NAME "*.c"

END

The AND in this definition’s rule means that a file must satisfy both

conditions in order to match it. In other words, it must hold text

and the last two characters of its name must be “.c”.

If the AND were replaced with OR, the definition would match files

that satisfied either condition—all text files or all files that end with
“nn

Cc.
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BINARY_DATA

Use the BINARY_DATA statement to match any file that contains

more than 5 percent control characters or characters with the high

bit set in the first two physical disk blocks. (Carriage returns, line-

feeds, tabs, and backspaces are not counted as control characters.)

BINARY_EXECUTABLE

Use the BINARY_EXECUTABLE statement to match any file that is

an executable binary file or command that is native to the system

Looking Glass is running under.

BLOCK_DEVICE

Use the BLOCK_DEVICE statement to match any block special

device file.

CHARACTER_DEVICE

Use the CHARACTER_DEVICE statement to match any character

special device file.

CONTENT

CONTENT Offset [TO Offset]

{STRING | BYTE | SHORT | LONG} [< | > | =]

{"String" | NumericValue}

Use the CONTENT statement to match files that have a given value

at a given offset or within a given range.

Offset is the position at which Looking Glass will begin searching

for the NumericValue. This argument must be provided. If Offset is

followed by the keyword TO, another Offset must be provided to

define a range in which the search will be made. All bounded

searches are carried out in a byte-by-byte fashion, including short

and long integers.

String is the string Looking Glass will search for in the file; it must

be enclosed in double quotes (”).
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The value may be specified as a quoted string (indicated by the

STRING keyword) or as an integer value (indicated by the BYTE,

SHORT, and LONG keywords).

You can also use the following operators to compare the data in the

file to a value:

Use this operator: To define a file type where a <value> is:

= Equal to the file data

This is the default operator, and the only one

that can be used with strings.

< Less than the file data

> Greater than the file data

Single-byte-replacement regular expression metacharacters can be

used in a string value. The following table lists the metacharacters

you can use:

Use this character: To match:

? Any character

[c,c, ...] One of the characters in the series

[c1-c2] One of the characters in the designated range

Integer values can be expressed in decimal, octal (with a leading 0),

or hexadecimal notation (with a leading Ox).
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DIRECTORY

DIRECTORY Name [Name ...]

Use the DIRECTORY statement to define the names of directories

that a file must be in to match the file type, or to define directory

names when creating a directory type. Directory names are treated

as strings that are compared to the full pathname of the current

directory.

Name is the pathname of a directory that a file must be in to match

a file type or the full pathname of a directory when creating a direc-

tory type.

It is usually a good idea to precede a full pathname with the “match

all” character (*), because network file systems often include a

mount directory that precedes the target. For example, */usr/bin

would match /usr/bin as well as /machineA/usr/bin.

DIRECTORY statements are most often used in conjunction with

CONTENT and/or NAME statements. If the Name includes special

characters, it must be placed in single or double quotes.

EMPTY

Use the EMPTY statement to match any empty file (in other words,

files of zero length).

FIFO

Use the FIFO statement to match any FIFO (named pipe) files.

NAME

NAME Name [Name ...]

Use the NAME statement to define file or directory names that

match a file type. Any number of names may be defined with the

NAME statement; each name must be separated by at least one

space.

Name is the name of a file that the file type will match.

Any Looking Glass regular expression metacharacter can be used if

that the name expression is enclosed in double quotes (").
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Pathnames are not allowed. Use the DIRECTORY statement to indi-

cate the file’s position in the file system or to define directory

names when creating a directory type.

SOCKET

Use the SOCKET statement to match any socket file. (On systems

that don’t support sockets or socket “files,” this rule is ignored.)

SYMBOLIC_LINK

Use the SYMBOLIC_LINK statement to match any symbolic link.

(On systems that don’t support symbolic links, this rule is ignored.)

TEXT

Use the TEXT statement to match any file that contains less than 5

percent control characters or any characters with the high bit set in

the first two physical blocks. (Carriage returns, linefeeds, tabs, and

backspaces are not counted as control characters.)

Parsing and syntax guidelines

This section describes general parsing and syntax rules for the File

Typing Compiler.

Comments

Comments are C language style, starting with /* and ending with */.

Keywords

Keywords must be in upper case.
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Looking Glass symbols

In COMMAND statements, the following Looking Glass symbols

can be used:

Inserts this

This option: symbol: With this value:

Selected Files #f The names of all the files cur-

(available only when Command rently selected in the Directory

Line is run from a Directory window) window

Selected Directories #td The names of all the directories

(available only when Command currently selected in the

Line is run from a Directory window) Directory window

Effective User fu The current user name

Effective Group #tg The group name associated with

the Looking Glass process

Current Directory #ic The full pathname of the current

directory

Regular expressions

The standard set of Looking Glass regular expression metacharacters

(Bourne Shell syntax) are allowed in the strings of COMMAND,

NAME, and DIRECTORY statements. Metacharacters other than the

asterisk (*) are also allowed in the strings of CONTENT rules.

Backslash as an escape character

Special characters such as # and “newline” can be escaped using the

backslash (\) character. Escape characters inside comments are

ignored. Special characters are not expanded if they are escaped.

For example:

COMMAND "\#f£"
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This command tells Looking Glass to try to execute “#£,” rather

than the name of the matching file that is normally represented by

the Looking Glass symbol #f.

The following table lists the special characters that are recognized:

This character sequence: Indicates this character:

\n Control+] (New Line)

\t Control+! (Tab)

\b Control+H (Backspace)

\r Control+M (Carriage Return)

\f Control+L (Form Feed)

Strings

Character strings may be enclosed in double or single quotes. (A

string is terminated by the same quote character that started it.)

Quotes within quotes are treated as part of the quoted string as long

as they aren’t the starting quote character.

A series of quoted strings is concatenated into a single quoted

string, except in NAME, DIRECTORY, and FEATURE_SET

statements.

For example:

COMMAND “echo " "one " "two " " "three "

is identical to:

COMMAND “echo one two three "

To include a control character in a quoted string, enter an escape

character (\) followed by the three-digit octal value for the

character.
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For example:

\001

would be interpreted as an ASCII start-of-header (Control-A)

character in the name.

White space

Extraneous white space (defined as newlines, blanks, and tabs) is

ignored. Note that this is not true of blanks in quoted strings.

Tokens

A single token (including series of quoted strings) cannot be longer

than 4095 characters.

File Typing Compiler reference

The following is a summary of the command-line interface to the

File Typing Compiler (FTC):

./fte {-l binaryInputFile | -c textInputFile}

([-L iconSymbolFile] [-x recordSymbolFile]

[-o binaryOutputFile]

At least one binary or text input file must be specified, preceded by

-1 or -c, respectively.

“.” may be used as the filename to designate standard input. Any

number of input files may be specified, but each must be preceded

by -1 or -c.

An icon symbol table file may be specified with -i. The default is

icons. sym.

A record symbol table file may be specified with -r. The default is

records. sym.

A binary output file may be specified with -o. By default, no out-

put is produced.
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File Typing Language example

This is an example for running the mythical Syforbase database on

any of its data files:

DEFINE TYPE SyforbaseDatabase

ICON DATABASE APP

FILE DESCRIPTION

"Syforbase Database File"

/*

* Any file with a '.sfb' extension in

* '/usr/syforbase' directory matches.

*/

NAME "*.sfb" AND DIRECTORY "*/syforbase" OR

/*

* The following (long) value at byte 42 is in the

* standard Syforbase header for version 3.4 and

* later.

*/

CONTENT 42 long 075643 OR

/*

* Look for the standard 16-bit magic number

* 064007 and of course the obligatory copyright

* notice.

*/

CONTENT O short 064007

AND CONTENT 48-150

string "(c) Copyright 19??

Syforbase"

COMMAND ATTRIBUTE:TERMINAL WINDOW

"/usr/bin/syforbase -r #f"

COMMAND DESCRIPTION

"Read file with syforbase"

/*

x Place the error output from the maintenance

* program in a file in /tmp with the name of the

* database with a ' err’ extension.

*/

COMMAND ATTRIBUTE : TTY

"/usr/bin/sfx_fixdb #f 2> /tmp/#f_err ; "

"echo Error output in \'/tmp/#f_err\' "

COMMAND DESCRIPTION

"Reconstruct file "
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This example defines a file type definition that runs the syforbase

database program if:

¢ The filename ends in “.sfb,” and the file resides in a directory

named syforbase /

or

¢ The first “sizeof(long)” bytes of the file from byte 42 contain

the (long) value 075643 octal

or

e The first “sizeof(short)” bytes of the file contain the (short)

value 0640 octal, and the string “(c) Copyright 19?? Syforbase”

starts anywhere in byte positions 48 through 150 inclusive.

(The question marks are regular expression metacharacters that

match any two characters.)
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commands in Create menu in Directory win-

dows 5-2

description of 2-10, 2-15, 2-18

directories and files on the Desktop Panel 9-6 to 7

entries in Section menu of Help window 3-15

Hyperpath menu 3-16

Directory command (Directory window) 5-2

Directory double-click action 12-22 to 23

Directory menu (Tree View window)

DIRECTORY statement 13-18, 13-26

directory panel (see also Tree View)

changing the display format of 6-18 to 19

definition of 6-2 to 4

Directory windows

accelerator keys for commands in 2-6 to 7



assigning colors to directories and files 4-17

bringing a window to the front of a stack of win-

dows 2-10 to 11

changing display formats in

Icon view 4-9 to 10

Name view 4-8 to 9

Wide view 4-10 to 11

changing information in 7-4 to 22

changing the directory displayed in the current

Directory window

by double-clicking 4-6

using the Change Directory command 4-6 to 7

changing the name of a directory or file 5-4, 7-4

to S

cleaning up repositioned directories and files

using the Clean Up command 4-15

using the Clean Up Selection command 4-15

closing windows

using Looking Glass 4-5

using the window manager 2-12 to 13

creating
devices 5-3

directories 5-2

FIFOs 5-2

files $-2

description of 1-11 to 12, 4-2 to 3

grouping selected directories and files 4-16 to 17

moving

stacking 4-8

to the foreground 4-7

opening

by double-clicking 4-3

using the Open command 4-4

using the Open directory command 4-4 to 5

resizing 2-11 to 12

retyping a directory 4-17 to 18

selecting all files or all directories in 5-15

sorting directories and files in 4-15 to 16

specifying
a directory double-click action 12-22 to 23

how titles are displayed in 12-17

the default position of the splitter in 12-20

the display format for directories and files

12-18 to 19

the number of seconds between display

updates 12-23

the size of 12-17 to 18

splitter

definition of 1-12

moving 4-14

specifying the default position of 12-20

viewing information in 7-2 to 4

display format

changing the current

to Icon view 4-9 to 10

Index hs 1-7

to Name view 4-8 to 9

to Positionable or Non-positionable format

4-13

to Wide view 4-10 to 11

changing the default

Directory window titles 12-17. |

display format for directories and files 12-18

to 19

for hidden directories or files in Directory

windows 12-19

positionable format for directories and files

12-19

size of new Directory windows 12-17 to 18

choosing whether to show or hide hidden files

4-12

display preferences

description of 12-16

specifying how Directory window titles are dis-

played 12-17

specifying the default position of the splitter in

Directory windows 12-20

specifying the display format for directories and

files 12-18 to 19

specifying the size of new Directory windows 12-

17

whether directories and files are posi-

tionable 12-19

specifying whether hidden files are displayed in

Directory windows 12-19 to 20

displaying
a terminal window 8-8

a Tree View window

directories 6-2 to 4

the display format of directory panels 6-18

to 19

the way names are displayed in title bars 6-

19 to 20

and changing the order of icons in a Gallery

window 10-11 to 12

and choosing actions for a file 8-3

changing the display order of icons in a Gallery

window 10-11 to 12

directories and files in Directory windows

in Icon view 4-9 to 10

in Name view 4-8 to 9

in Wide format 4-10 to 11

directories or files on the Desktop Panel

by dragging 9-7

by full pathname 9-8

by name or icon 9-8

with the Put On Desktop Panel a Help win-

dow 3-2 to 4, 3-9, 3-14 to 17

Directory windows

by double-clicking 4-3 to 4

using the Open command 4-3 to 4
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using the Open Directory command 4-3 to 5

the History window 3-7 to 8

the Index window 3-5 to 7, 3-12 to 13

Display Preferences command (Global Window) 12-17

distinguishing one file type from another 13-22

double-click actions

command section shell commands 13-3

specifying 12-22 to 23

double-clicking

definition of 2-2

on any word in a Help window to open the

Index window 3-7

on hypertext links 3-14 to 15

to activate a file 8-2

to change the directory displayed by 4-6

to close a directory in Tree View 6-15

to display the name of a directory or file in the

Find dialog 5-12

to eliminate unused space between categories in

Wide view 4-11

to erase the entire editing area with the Pencil

tool 10-23

to open

a directory in Tree View 6-11

the Editing window for an icon 10-19

windows 4-3 to 4

to select the entire editing area

using the Lasso tool 10-22

using the Selection tool 10-22

to sort by a category in Wide view 4-11

to start the Icon Editor from Looking Glass 10-2

double-click speed 12-22

dragging
definition of 2-3

directories and files in Positionable format 4-13

directories and files to new positions on the

Desktop Panel 9-9

directories and files to the Desktop Panel 9-7

the slide arrow to adjust a value with a scale bar

2-24

the slider box to scroll to a specific location 2-23

the splitter to adjust the amount of space in a

Directory window 4-14

to copy selected files 5-18

to define a new color for user interface elements

12-5

to delete text in a field 2-18

to increase or decrease the width of a column in

Wide view 4-11

to move a column from one position to another

in Wide view 4-11

to move a window to another position on the

workspace 2-10

to move selected files 5-16

to remove a category from the display in Wide

view 4-11

to replace text in a field 2-18

to resize a window using the frame 2-12

to select a group of directories in Tree View 6-5

to 6

to select all or part of an icon with the Lasso tool

10-22

to select all or part of an icon with the Selection

tool 10-22

to select icons in Gallery windows 10-11

to select text in a text box 2-5

to set the default size of new Directory windows

12-18

drawing

constrained to a horizontal or vertical line 10-23

ellipses using the Ellipse tool 10-23

one pixel at a time using the Pencil tool 10-23

rectangles using the Rectangle tool 10-23

straight lines using the Line tool 10-23

Duplicate command (Gallery window) 10-12 to 13

Edit command (Gallery window) 10-18 to 19

Edit menu (Editing window) 10-21, 10-24

Edit menu (Gallery window) 10-12 to 13

editing

areas 10-19, 10-21 to 23

commands 8-5 to 6

environment variables 11-3 to 4

files 1-2, 12-7 to 10, 13-5

icons 1-13, 10-12 to 16, 10-18 to 27

names of directories or files 5-3 to 4, 7-4 to 5S

text in a text field 2-17 to 18

Editing window 10-10, 10-18 to 19, 10-21 to 22, 10-

24, 10-26 to 27

Icon editing area 10-19

Mask editing area 10-19

Preview boxes 10-19 to 22

Image preview box 10-19 to 20

Mask preview box 10-19 to 20

Selected Icon preview box 10-19 to 20

Unselected Icon preview box 10-19 to 20

Tool palette 10-19, 10-22 to 23

editor

quitting the Icon Editor program 10-6

specifying text and data editors 12-8 to 10

starting the Icon Editor program 10-1 to S

by double-clicking 10-2

specifying command-line arguments 10-3 to S

using the Icon Editor command 10-2 to 3

eliminating unused space between two categories in

Wide format 4-11

Ellipse tool 10-23



EMPTY statement 13-6, 13-22, 13-26

END statement 13-3, 13-11, 13-13, 13-19

enlarging windows 2-12

entering

commands 8-5, 8-8

the help system 3-2 to 3, 3-5, 3-9

using the Help command 3-3 to 4

using the Help or F1 key 3-2 to 3

the Icon Editor 10-2 to 5

environment variables

adding 11-4

editing 11-3

HOME 11-2

LG_FEATURE_SET 11-2, 13-10 to 11, 13-19

names of variables you cannot change or delete

11-2

PATH environment variable 11-2, 13-15

removing 11-5

TERM environment variable 11-2

using 11-2

Environment Variables command (Global Window)

11-3 to $

Eraser tool 10-23

escape characters 13-28 to 29

excluding access permission 12-12 to 14

execute check box 12-12 to 15

execute permission 7-5 to 7, 7-17

execu

files 7-8 to 9, 7-19

programs 1-3

execution option 7-7 to 8, 7-15, 7-18 to 19

execution preference 5-21, 12-7 to 12, 13-9 to 10, 13-15,

13-17

Execution Preferences command (global Window)

12-7 to 8, 12-10 to 11

exit codes 10-29 to 30

exiting programs 8-4

Export command (Gallery window) 10-13, 10-15 to 16

extending selections 6-6

F
F1 (Help) key 2-7, 3-2, 3-9

FEATURE_SET 11-2, 13-10 to 11, 13-18 to 19, 13-29

FEATURE, SET environment variable 13-10 to 11, 13-19

feature symbols 13-18 to 19

FIFO

creating 5-2

statement 13-26

FIFO command (Directory window) 5-2

File command (Directory window) 5-2

FILE_DESCRIPTION statement 13-19

File menu

Desktop Panel 9-6 to 9

Index he. 1-9

Directory window 4-4 to 6, 4-18, 5-S, 5-7 to 8, 5-16

to 17, 5-19 to 21, 7-3 to 4, 7-6, 7-8 to 10, 7-12 to

13, 7-15, 7-17 to 18, 7-20 to 21, 8-2, 9-7

Editing window 10-21, 10-27

Gallery window 10-6 to 10, 10-13, 10-17

Icon Editor window 10-6 to 9, 10-17

File System Server (FSS) 13-2

file type definition 13-3 to 15, 13-17 to 22

assigning an icon 13-6

building the command section 13-8 to 10

compiling 13-2, 13-5 ,13-13 to 14, 13-27, 13-30

ending 13-3, 13-11, 13-18 to 19

format 13-4

sample 13-31

selecting a source file 13-4

testing 13-10 to 11

File Typing Compiler (FTC) 13-2

parsing and syntax 13-27

reference 13-30

File Typing Language (FTL) 13-1

backslash as an escape character 13-28

comments 13-27

definition 13-2

escape character 13-28 to 29

general rules 13-7

keywords P-3, 13-5 to 6, 13-13, 13-27

Looking Glass symbols 13-15, 13-28 to 29

organizing rules for maximum efficiency 13-8

parsing and syntax guidelines 13-27

regular expressions 13-25 to 26, 13-28

characters 5-10 to 11, 5-13 to 14, 6-21,

13-26, 13-28 to 29

strings 13-29 to 30

white space 13-30

file typing rulebase 10-27 to 28 13-2

installing 13-12

file typing rules 4-18, 13-2, 13-10

Fill tool 10-22

Find command (Directory window) S-9 to 12

Find command (Global window) 5-9 to 11

Find command (Tree View window) 2-7, 6-21

finding

directories and files in a Directory window 5-9 to 14

directories and files in a Tree view window 6-21

names of icon galleries 10-7, 10-11

names that match a pattern 5-10 to 12

Force Job Termination command (Global window)

8-2, 8-4

forcing monochrome display on a color monitor 1-5,

10-4

foreground

color 1-5, 10-5, 10-20, 10-26, 12-2 to 3

moving windows 2-10, 3-7 to 8, 4-7, 5-12 to 13

format

bitmap file format 10-15
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display formats 1-11, 4-8 to 16, 12-18 to 19

directory panels 6-18

Directory windows 4-8 to 13

Non-positionable format 4-13 to 16, 12-19

Positionable format 4-13, 4-15

of a file type definition 13-3

of file typing source code 13-4

Print Formatter 12-11 to 12, 13-17

print formatting command 13-10, 13-15,

text files 5-21, 12-7, 12-11, 13-9

frames

around windows in Looking Glass 1-5

around windows in the Icon Editor 10-4

FSS (File System Server) 13-2

FTC (File Typing Compiler) 13-2

FTL File Typing Language) 13-2

Full Pathname check box (Tree View window) 6-18

to 19

G
galleries

creating 10-8 to 9

description 10-6

opening 10-6 to 8

saving 10-9 to 10

Gallery window 10-2 to 3, 10-6 to 13

general rules for creating file type definitions 13-4 to 12

generating a file typing rulebase 13-22 to 23

generic document icon 13-6

gen.loc.ftc 13-5

getting help in Looking Glass 3-2 to 8

getting information about directories and files 7-2 to 3

Global window 1-8 to10, 2-6, 2-13

Group Access command (Directory window) 4-10

Group Modified command (Gallery window) 10-12

group name

#g symbol for 8-6, 13-15, 13-28

Group Name command (Directory window) 4-16

Group Selected command (Gallery window) 10-12

Group Selected Objects command (Directory win-

dow) 4-17

grouping selected files and directories in a Directory

window 4-17

hard link 5-5 to 7

Help command (Global window) 3-3 to 4

Help or F1 key 3-2, 3-9

help system

detouring 3-9, 3-17

jumping 3-4, 3-9 to 10, 3-12, 3-14 to 17

types of help windows 3-4 to 8

walking 3-9 to 10, 3-16 to 17

Help window 3-3 to 5, 3-7, 3-9 to 12, 3-14 to 17

subtopics 3-5, 3-7, 3-9 to 10 3-12 to 15

hidden files 4-12, 12-19 to 20, 13-14

hidden

directories 6-12 to 13

directory panels 6-4

files 4-12, 12-19 to 20, 13-14

windows 2-11

highlighting an object 2-2 to 5

History arrows (Help window) 3-9, 3-11, 3-16

History button (Help window) 3-8

history list

Change Directory dialog 4-7

Close Directory In Tree dialog 6-16

Command Line dialog 8-5 to 8

Copy dialog 5-19

Help window 3-11, 3-17

History window (Help system) 3-4, 3-7 to 9, 3-17

Link dialog 5-7 to 8

Move dialog 5-18

Open Directory dialog 4-4 to 5

Open Directory In Tree dialog 6-13 to 14

home directory

creating links for 5-7 to 8

displaying 4-3, 4-5, 4-7

icon for 1-14

in the Command Line dialog 8-5, 8-8

moving files to 5-18 to 19

showing in Tree View 6-2, 6-13 to 16

using an environment variable for 11-2

HOME environment variable 11-2

HSB (hue, saturation, brightness) method 12-3, 12-5

hyperpath 3-9, 3-12, 3-14 to 17

Hyperpath menu (Help window) 3-9, 3-12, 3-14, 3-16

to 17

hypertext link 3-4, 3-9, 3-12, 3-14

Icon command (Desktop Panel) 9-8

Icon command (Directory window) 4-9 to 10

Icon command (Tree View window) 2-7, 6-18 to 19

Icon Editor

assigning icons to a file type 13-6

brief tour 10-1

choosing the icons you want to edit 10-11

clipboard 10-12 to 24

closing icon galleries 10-17, 10-27

closing the current Editing window 10-27

cutting, copying, and pasting icons 10-12, 10-13,

10-21, 10-24

drawing

circles 10-23

horizontal lines 10-23

lines 10-23



one pixel at a time 10-23

ovals (ellipses) 10-23

rectangles 10-23

editing icons 10-18, 10-21

erasing 10-23

making a copy of a selected area 10-24

masks

changing 10-19 to 20, 10-24 to 27

creating 10-24 to 26

opening icon galleries 10-6 to 8, 10-18 to 19

preview boxes

description of 10-19 to 21, 26

Image preview box 10-19 to 20

Mask preview box 10-19 to 20

Selected Icon preview box 10-19 to 20

Unselected Icon preview box 10-19 to 20

quitting the Icon Editor 10-3, 10-6

removing with the selection tool 10-22

renaming an icon 10-16 to 17

restoring the last saved version of an icon 10-10

saving

icons 10-6, 10-8 to 9, 10-17, 10-27

icon galleries 10-6, 10-8 to 9, 10-17, 10-27

under a new name 10-9

under its current name 10-9

selecting

areas by drawing freehand 10-22

editing areas 10-22

icons and parts of icons 10-22

rectangular areas by dragging 10-22

sorting

by modification 10-12

by name 10-12

tools 10-22 to 23

window 10-2 to 3, 10-6 to 9, 10-17

Icon Editor command (Global window) 10-2

Icon Editor window 10-2 to 3, 10-6 to 9, 10-17

Icon menu (Gallery window) 10-13 to 15

Icon preview box 10-19 to 20

ICON statement 13-3, 13-20

Icon view 4-9 to 10, 4-17, 13-3, 13-6

icons

assigning an icon to a file type definition 13-6

creating 10-18 to 24

displayed in the Global window 1-10, 8-2, 8-4

editing 10-12 to 16

fanned 1-14, 6-7

file type definitions for 13-2, 13-12, 13-18, 13-20

icon symbol table 13-30

in Directory windows 1-11, 4-17, 5-17 to 18, 12-18,

in the Desktop Panel 4-17, 5-17 to 18, 9-5,

introduction to 1-13 to 14

lining up on a grid 12-15 to 16

preloading icon images 1-6

saving 10-9, 10-27

Index hs. i-11

selecting 2-2, 6-4,

viewing 10-6

icons.sym 13-11 to 12, 13-30

Image preview box (Editing window) 10-19 to 20

Import command (Gallery window) 10-13 to 14

indexed keywords 3-4 to 5, 3-7

indexed words P-1

Index button (Help window) 3-S, 3-7

Index window (Help window) 3-3 to 10, 3-12 to 15

Information command (Directory window) 2-6, 7-2

to 4, 7-6, 7-8 to 10, 7-12 to 14

INHERIT_COMMANDS statement 13-20

inheritance 13-20

inheriting a creation mask 12-12 to 13

inode 4-10, 7-2

Inode command (Directory window) 4-10

inserting

data into a command line or directory path 11-2

directory and filenames in the current Directory

window 8-5

special symbols 8-6, 12-9, 12-11, 13-28

insertion cursor 2-2, 2-18

installing

application programs 13-14, 13-21

file typing rules in the Looking Glass rulebase 13-

11 to 12

Looking Glass 1-3

new icons 10-27 to 28

intrinsic

components 13-8

keywords 13-6

typing rule statements 13-22

invoking programs

by double-clicking 8-2

from a terminal window 8-8, 12-7 to 8

from an external shell 12-10

text and data editors 12-8 to 10

using the Command Line dialog 8-5

using the Open command 8-2

jobs

definition of 8-4

terminating 8-4

forcing termination 8-2, 8-4

requesting termination 8-2, 8-4, 8-7

Jobs menu (Global window) 8-2, 8-4

jumping to new topics in the help system 3, 3-9, 3-12,

3-14 to 17

using hypertext links 3-4, 3-14

using the Hyperpath menu 3-16

using the Section menu 3-15
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K
keystrokes 2-8

accelerator keys 2-6 to 7

seconds between 10-7, 10-11

keywords |

File Typing Language P-3, 13-4 to 6, 13-11, 13-13

to 14, 13-17 to 18, 13-21, 13-24 to 25, 13-27

help system 3-4 to 5, 3-7

killing (terminating) a job 8-2, 8-4

Korn shell 12-10

L
Lasso tool 10-22, 10-24

launching an application 1-2, 1-6 to 7, 1-10

layers of an icon 10-25 to 26

layouts

Looking Glass workspace 9-2 to 5

Tree View 6-2, 6-21 to 24

Layouts command (Global window) 9-2 to 5

leaving the Icon Editor 10-6

LG_FEATURE,_ SET environment variable 11-2, 13-10

to 11, 13-19

lg _ftc 13-4, 13-11 to 12

LG rulebase 13-2, 13-11 to 12

License Server 1-2

Line tool 10-23

Link command (Directory window) 2-6, 5-7 to 8

Link Content command (Directory window) 4-10

linked reference 5-6 to 8

links

definition of 5-4

hard link 5-5 to 8

linking multiple files or one or more directories 5-8

symbolic link

absolute 5-6, 5-9

definition of 5-5 to 6

relative 5-6, 5-9

SYMBOLIC_LINK statement 13-6, 13-27

Links command (Directory window) 4-10

List of saved layouts (Global window) 9-3

listing selected directories and files first in a Directory

window 5-15 to 16

login shell 1-2 to 3

LONG keyword 13-25

machine display used by Looking Glass 1-6, 10-5

malfunctioning programs 8-4

mask

changing all or part of 10-26 to 27

creating 10-24 to 26

definition of 10-24

Mask preview box (Editing window) 10-19 to 20

Mask Selection command (Editing window) 10-21,

10-24 to 26

“match all” character 13-18

matching

file type definitions 13-6 to 7, 13-9, 13-15, 13-17,

13-19, 13-22 to 26, 13-29, 13-32

names of directories or files 5-10 to 11, 5-13 to 15

symbolic links 13-27

Maximize button 2-9, 2-12

memory 12-21, 13-2

menu bar 10-19

menus

option 2-15 to 16

pop-up 2-16 to 17

pull-down 2-14 to 15

title 2-17

Merge In Saved Tree command (Tree View window)

2-7, 6-23 to 24

me

icon galleries 10-27 to 30

icons 10-18

Tree View layouts 6-23 to 24

metacharacters 13-25 to 26, 13-28, 13-32

Minimize button 2-9

Modification field 7-11

Modification Time command (Directory window) 4-10,

4-16

modifying
date and time information 7-10 to 11, 7-19 to 20

file typing definitions 13-4, 13-14, 13-21

file typing rulebase 10-28

icons 10-6, 10-11 to 12

monitor

color 1-5, 10-4, 10-20, 10-26, 12-2

monochrome 10-19

mounted directories and files 5-5, 13-18, 13-26

mouse

clicking 2-2

double-clicking 2-3

dragging 2-3 to 5S

mouse actions 2-2, 5-16, 12-23

mouse buttons 2-2

Shift-clicking 2-3

Move command (Directory window) 5-16 to 18

moving

by dragging 2-4, 5-16 to 17

columns from one position to another in Wide

format 4-11

cursor to the place where you click 2-2

directories and files to the Desktop Panel 9-7

Directory windows to the foreground 4-7

files 1-2, 1-11 to 12, 4-13, 4-15, 5-16 to 18, 9-6, 9-9

to 10, 12-21

through the help system 3-9

windows 2-8, 2-10 to 11, 2-21, 4-7, 4-14, 9-6, 10-12



windows to the foreground 2-10, 3-7 to 8, 4-7, 5-12

to 13

Name command (Directory window) 4-8 to 9, 4-15

to 16

Name command (Desktop Panel) 9-8

Name command (Tree View window) 2-7, 6-18 to 19

name of new icon gallery 10-8

Name option 13-14, 13-17

NAME mule 13-22, 13-26

NAME statement 13-23, 13-26

Name view 1-8, 4-8 to 9, 4-15, 6-19, 12-16

New command (Gallery window) 10-8, 10-13

New Gallery command (Icon Editor window) 10-8

Non-positionable format 4-13 to 16, 12-19

nopreload 1-6

NOT operator 13-23

O
object P-1

OK button 2-18

Open command (Desktop Panel) 2-7, 8-2, 9-8

Open command (Directory window) 2-6, 4-3 to 4, 8-2

Open command (Gallery window) 10-7, 10-13

Open Directory command (Global window) 2-6, 4-3

to 5

Open Gallery command (Icon Editor window) 10-7

opening

directories 4-4 to 5

allowing others to open your directories 7-17,

12-12 to 15

at startup 1-3 to 4

directory windows from Tree View 6-17 to

18

fanned directory icon indicating that it is

open 1-14

from the Desktop Panel 9-8

in the Tree View window 6-11 to 13, 6-15, 6-21

to 22

more than one at a time 4-4

selecting all open directories in Tree View 6-7

to 8

directory panels 6-3

Directory windows

by double-clicking 4-3

from Tree View 6-17 to 18

new Directory windows 4-6, 12-22 to 23

with or without the splitter 12-19

files 8-2, 9-8, 13-16

from the Global window 9-6

in a new Directory window 4-6

icon galleries 10-6

Index bh. 1-13

subdirectories in Tree View 6-20

terminal emulator window 8-8

Tree View window 6-2

Open In Tree command (Tree View window) 2-7, 6-11

to 12

Open In Window command (Tree View window) 2-7,

6-17

Open Saved Tree command (Tree View window) 2-7,

6-23

Operational Preferences command (Global window)

4-4, 12-20 to 23

operators for typing rule statements 13-7, 13-23, 13-25

option menus 2-15 to 16

options that control the operation of Looking Glass

12-1

OR operator 13-23

organization of this user's guide P-1

OSF/Motif 2-1

Other Access command (Directory window) 4-10

outlined type P-2

Oval (Ellipse) tool 10-23.

Owner Access command (Directory window) 4-10

Owner Name command (Directory window) 4-16

Owner Name command (Directory window) 4-16

P
Paint (Fill) tool 10-22

palette (tool) 10-19, 10-22 to 23

panel

Desktop 1-9, 1-12 to 13, 2-7, 9-S to 10

directory 6-2 to 4

parent directory 4-2, 6-3 to 4, 6-20, 10-7

Parent Directories command (Tree View window) 2-7,

6-8 to 9

parsing and syntax guidelines 13-13, 13-27

passing information between programs 11-2

Paste command (Editing window) 10-21 to 24

Paste command (Gallery window) 10-12 to 13

pasting icons 10-12 to 13, 10-21, 10-24

PATH environment variable 11-2, 13-15

pathname

file types and pathnames 13-15, 13-17 to 18, 13-26

to 28

Find command and pathnames 5-11

full pathname in title bars 4-2, 9-8, 6-19 to 20,

10-8

in Command Line dialog 8-6

in Directory windows 4-6

links and pathnames 5-4 to 9

Main Icon Gallery’s full pathname 10-6

naming a Tree View with a pathname 6-22

opening a directory using its pathname 10-16

renaming an icon gallery using the full or rela-

tive pathname 10-10
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a directory using its pathname 4-5, 4-7,

5-18 to 19, 6-13, 6-15 to 16, 6-18

specifying a terminal emulator using the path-

name of the program 12-7

specifying text and data editors using the path-

name of the program 12-8

Pencil tool 10-23, 10-26

permission (see access permissions)

Phrase list (Help window) 3-6 to 7

pixel

description of 10-20 to 23, 10-25 to 26

platform 13-19

pointer

crosshair 10-23

dragging the pointer 6-5 to 6

eraser 10-23

paint can 10-22

pencil 10-23

pointing device 2-2

pop-up menus 2-16 to 17

Positionable command (Directory window) 4-12 to

13, 4-15, 5-15

preferences

cleanup 12-15

color 12-2 to 4

creation 12-12 to 14

display 12-16 to 20, 12-23

execution 12-7 to 11, 13-9 to 10, 13-15, 13-17

operational 12-20 to 23

removal 12-5 to 6

preview

Icon Editor preview boxes

description of 10-19 to 21, 10-26

Image preview box 10-19 to 20

Mask preview box 10-19 to 20

Selected Icon preview box 10-19 to 20

Unselected Icon preview box 10-19 to 20

Cleanup Preferences preview area 12-16

Layouts preview area 9-3 to 4

Print command (Desktop Panel) 2-7, 9-9, 12-11

Print command (Directory window) 2-6, 5-21, 12-11

printing
accelerator key 2-6 to 7

changing preferences 12-11 to 12

command-line arguments 1-4

files 5-21

File Typing Language statements

ATTRIBUTE : PRINTABLE 13-13, 13-15, 13-20

COMMAND : PRINT 13-13, 13-17, 13-20 to 21

from the Desktop Panel 9-9

in the command section of the FTL 13-3, 13-8 to 10

Print Formatter 12-11 to 12, 13-10, 13-17

Print Spooler field 12-11

prog.loc.fte 13-5

protection modes (see access permissions)

pull-down menus 12-14 to 15

push button

default button 2-19

description of 2-18 to 19

Put On Desktop Panel command (Directory window)

9-7

Q
question mark (7) 3-2 to 3

Quit command (Gallery window) 10-6

Quit command (Icon Editor window) 10-6

Quit Looking Glass command (Global window) 1-6

to 7

quitting
a find operation 5-12

an application 2-13

Icon Editor 10-6

Looking Glass 1-6 to 7, 1-10, 3-8

to install a new set of file typing rules 13-12

radio buttons 2-20 to 21

radio buttons 2-20

readout box 12-4 to S$

records.sym 13-11 to 12, 13-30

Rectangle tool 10-23

REDEFINE_DIRECTORY statement 13-21

REDEFINE_TYPE statement 13-21

regular expressions 13-28

relative symbolic links

creating 5-8 to 9

definition of 5-6

Removal Preferences command (Global window) 12-6

Remove command (Directory window) 5-20

removing

categories from Wide format display 4-11, 4-16

directories and files from Directory windows 1-2,

1-11, 5-S, 5-20

directories and files from the Desktop Panel 9-5,

9-7

environment variables 11-4 to 5

icons from a Gallery window 10-12, 10-24

layouts 9-4 to 5

links to directories and files 5-6

permissions for files and directories 7-7, 7-16 to

18, 12-13 to 15

preventing accidental removal of directories and

files 7-S

setting removal preferences 12-6

the splitter from Directory windows 1-12, 4-12 to

13
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an icon 10-16 to 18

an icon gallery 10-9

directories and files 5-3, 7-4

Rename command (Gallery window) 10-16 to 18

replacing

access permissions 7-16 to 18

command-line arguments 8-7, 13-9 to 10

icons in the Main Gallery 10-27 to 28

items on the clipboard 10-24

layouts 9-5

text in a text box 2-17 to 18

the contents of a Directory window 12-22

Tree View layouts 6-23

repositioning directories and files 1-12, 4-13 to 15

Request Job Termination command (Global win-

dow) 8-4

resizing

column headings in Wide view 4-11

the Desktop Panel 9-6

windows 2-8 to 9, 2-11 to 12

restarting

a Find operation 5-12

when installing new file typing rules 13-11 to 12

Restore button 3-7

restoring

a directory or file name in a Directory window 54

a Help window entry 3-7 to 8, 3-11

a maximized window 2-12

directory panel arrangement in Tree View 6-2

the last saved version of an icon or gallery 10-10

window arrangement when starting Looking

Glass 1-7, 9-1

retracing your steps through help 3-1, 3-16

Retype Directory command (Directory window) 4-17

retyping a directory 4-17 to 18, 13-12

Revert button 12-16

Revert command (Editing window) 10-10

Revert command (Gallery window) 10-10

reverting

to the last cleanup preference saved 12-16

to the last icon gallery saved 10-10

RGB (red, green, blue) method 12-3, 12-5

R (read) permission 7-S to 7

rulebase

defining file types

building file matching rules 13-7

building file type definitions 13-4 to 5

installing 13-11 to 12

description of 13-2

installing new icons 10-27 to 28

tule statement 13-3, 13-6, 13-22

Run button 8-7

Run menu (Global window) 2-6, 8-5, 8-8, 10-2, 12-7,

12-10

index he 1-15

Looking Glass from a command line 1-3

programs

by double-clicking 8-2, 13-15 to 16

from the Desktop Panel 9-5

using the Command Line dialog 8-5 to 7

using the Open command 8-2 __

using a terminal emulator 4-17, 8-8

files 7-5 to 7, 7-17

Icon Editor

from a command line 10-3

from Looking Glass 10-2

while installing new file typing rules 13-12

$
sample file type definition 13-31

saturation 12-3, 12-5

Save As command (Gallery window) 10-8 to 9

Save command (Gallery window) 10-9 to 10, 10-13

Save Tree As (Tree View window) 2-7, 6-21, 6-23

sa

layouts 1-13, 9-1 to 5

Tree View layouts 6-21 to 24

Icon Editor

exporting icons as bitmap files 10-16 to 18

icon galleries 10-8 to 10, 10-12, 10-21

icons in an Editing window 10-27

icons to the Main Gallery 10-6, 10-21

images to the clipboard 10-24

imported bitmap files as icons 10-15

environment variables 11-4 to 5, 13-11

scale bar

description of 2-23 to 24

slide arrow 2-24, 12-5

scrolling

a variable amount 2-23

line by line 2-22

one windowful of information 2-22

scroll bar 2-21 to 22

scroll region 2-22 to 23

slider box 2-21 to 23

searching using the Find command 5-9 to 12, 6-4, 6-21

security 12-12

Select All command (Gallery window) 10-12 to 13,

10-21, 10-24

Select All Directories command (Directory window)

5-15

Select All Files command (Directory window) 5-15

Select By Pattern command (Directory window) 5-13,

5-15

selected directories

#d symbol for 8-6, 13-28

selected files
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#£ symbol for 8-6, 13-28

Selected Icon preview box 10-19 to 20

selecting

a help topic 3-12 to 17

a rectangular area by dragging 2-3 to 4

a source file for a file type definition 13-4 to 5

a word 2-3, 2-5

all directories 2-3 to 4, 5-15 6-4, 6-6 to 11

all files 2-6, 5-15, 13-16

an action for a file 8-3

by clicking 2-2, 12, 15 to 17, 19 to 21, 23

by double-clicking 2-3

by dragging 2-3

check boxes 2-20 to 21

names that match a pattern 5-10

radio buttons 2-20

several files and directories at one time 2-3 to 4

text 2-2 to 3, 2-5

Select menu 5-9 to 10, 5-13, 5-15, 6-7 to 11

Selection tool 10-15, 10-22, 10-24, 10-26

setting

access permissions

for directories and files 7-6 to 9

for symbolic links 5-9, 7-6

display variables

for Looking Glass 4-3

for the Icon Editor 10-S

double-click speed 12-22

execution options 7-7 to 8, 7-18 to 19

limit for file size 12-21 to 22

number of seconds between display updates 12-23

preferences 12-2 to 21

size of the Copy buffer 12-21

shell

exiting a shell 2-13

shell commands in file type definitions 13-3, 13-5,

13-15, 13-28

specifying an external shell 12-10

starting Looking Glass from a login shell 1-2 to 4

using a shell script to execute text and data edi-

tors 12-10

showing

directories and files in Directory windows 5-12,

9-8 to 9

directories and files in Tree View 6-13 to 15, 6-21

hidden files 4-12

Show command (Desktop Panel) 2-7

Show Full Pathname command (Desktop Panel) 9-8

Show Hidden Files command (Directory window) 4-12

Show In Tree command (Tree View window) 6-13 to 14

Show menu 3-3, 5-9 to 10, 6-2, 9-6, 11-3 to 5

specifying an external shell 12-10

SHORT keyword 13-25

SINGLE_ARGUMENT statement 13-6

slide arrow 2-24, 12-5

slider box 2-22 to 23

SOCKET statement 13-27

Sorted command (Tree View window) 6-20

sorting

directories and files in a Directory window

by color 4-15

by name 6-1, 10-12

in ascending or descending order 4-15

directories and files in Wide view 4-11

directory panels in Tree View 6-20, 6-22

icons in a Gallery window 10-10, 10-12

Sort menu 4-14 to 17, 5-16, 10-8, 10-12

special symbols 8-6, 13-28

splitter

changing to Non-positionable format 4-12 to 14

description of 1-12

specifying the default format 12-19 to 20

spooler

print instructions in a file type definition 13-9 to 10

printing files 5-21

specifying a default print spooler 12-11 to 12

Stack command (Global Window) 4-8

stacking windows 2-10 to 11, 4-7 to 8

startup arguments (see arguments)

Icon Editor

from a command line 10-3

from Looking Glass 10-2

Looking Glass

as a login shell 1-2

from a command line 1-3

the License Server 1-2

programs (see running)

stopping
a Find operation $-12

jobs that were launched from Looking Glass 8-4,

8-7

storing

colors 4-17

command history 8-5, 8-7

creation masks 12-12 to 13

date and time information 7-10

file type definition 13-4 to 5

icons 10-6, 10-12, 10-18, 10-24

LG_rulebase 13-2

Tree layouts 6-21

STRING keyword 13-25

style conventions in manual P-2 to 4

Subdirectories command (Tree View window) 2-7, 6-8

to9

subdirectory

defining creation masks for 12-14 to 15

deleting 5-20

displaying 1-12, 4-2, 12-19

in Tree View



closing 6-15 to 17

description 6-2

finding 6-21

opening 6-11 to 13

opening Directory windows for 6-17 to 18

relationships 6-3 to 4

selecting 6-4 to 11

showing 6-13 to 15

searching 5-12

subtree 6-10 to 11

Subtrees command (Tree View window) 2-7, 6-10

symbolic link

creating 5-8 to9

definition of 5-5 to 6

information about 7-4, 7-6

SYMBOLIC_LINK keyword 13-6

SYMBOLIC_LINK statement 13-27

systems (see file system)

System menu 1-6, 2-15, 4-4, 4-14, 8-8, 12-3, 12-6 to

8, 10 to 15, 17 to 23

T
Take Off Desktop Panel command (Desktop Panel) 9-7

TERM 11-2

Terminal Emulator (Directory window) 8-8

Terminal Emulator (Global window) 12-10

TERMINAL_WINDOW statement 13-16

terminating jobs 8-4, 8-7

text box

description of 2-17 to 19

in help 3-7

TEXT statement 13-27

title

bar of Directory windows 2-9 to 10, 4-2

line in Wide view 4-11

of directory panels 6-2, 6-4 to 5

of Directory windows 12-16 to 17

of icon galleries 10-8

of lists 2-20

of menus 2-14 to 17

token 13-30

tools 10-15, 10-19, 10-22 to 24, 10-26

top shadow 1-6, 10-5, 12-2 to 3

Tree View

closing directories in 6-15 to 6-16

description of 6-3 to 4

directory panels

changing the display 6-18 to 20

description of 6-2 to 3

opening 6-11 to 13

organizing 6-20

opening Tree View 6-2

saving Trees 6-21 to 6-24

selecting directories 6-4 to 11

index hs 1-17

showing directories 6-13 to 15

TTY statement 13-6

typing (see also file typing)
accelerator keys P-2

text in a field 2-18 to 19

text in Courier font P-3

U
Undo command (Editing window) 10-21, 10-23

undoing

changes to an icon 10-21, 10-23 to 24

changes to an icon gallery 10-10

Unselected Directories command (Tree View win-

dow) 6-8

Unselected Icon preview box 10-19 to 20

unselecting

by clicking 2-2 to 3

by pattern 5-15

selected directories in Tree View 6-4, 6-8, 6-11

updating
Looking Glass 13-14, 13-21

the .lgdb file 13-2

the display in Directory windows 12-23

user name

#4 symbol for 8-6, 13-15, 13-28,

utility programs

example for running 8-7

icon merge 10-18, 10-28 to 29

make 13-12

uwn 1-4

V
View menu (Desktop Panel) 9-8 to 10

View menu (Directory window) 4-9 to 10, 4-12 to 13,

7-1

View menu (Tree View window) 6-18, 6-20

viewing

actions for a file 8-3

by Icon in a Directory window 4-9 to 10, 4-17,

13-3, 13-6

by Name in a Directory window 4-8 to 9

changing view permissions 12-14 to 15

directories and files on the Desktop Panel 9-7 to 8

directories in Tree View 6-2 to 4

environment variables 11-3

in Wide view in a Directory window 4-10 to 12

information for directories and files 7-2 to 4

objects found with the Find command 5-12

setting the default view 12-18 to 19
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Ww
W (write) permission 5-2, 7-5 to 7, 10-6, 10-18, 10-

21, 12-12

walking through the help system 3-9, 3-17

Wide view

eliminating unused space between categories 4-11

increasing or decreasing the size of headings 4-11

moving columns from one position to another

4-11

removing a category from the display 4-11

sorting in Wide View 4-11

window manager

determining window position on the workspace

12-7

frameless window managers 2-8, 10-4

uwm 1-4

mwm 2-8 to 13

Windows menu 2-11, 2-19, 4-3 to 4, 4-7 to 8

words printed in

bold P-2 to 3, 1-5, 10-4

boldface Courier font P-3

Courier font P-2 to 3

workspace

changing the default color 12-2

description 1-7

determining window position on the workspace

12-7

layouts 1-13 to 14, 9-2 to 7

moving windows around 2-10 to 13, 4-7 to 8

opening directories on 4-3 to 4

X
X (execute) permission 5-2, 7-S to 7



1. Anorder can be placed with the TIPS group in two ways:

a) MAIL ORDER - Use the order form on the opposite page and fill in all requested information. Be sure to include

shipping charges and local sales tax. If applicable, write in your tax exempt number in the space provided on the order

form.

Send your order form with payment to: Data General Corporation

ATTN: Educational Services/TIPS G155

4400 Computer Drive

Westboro, MA 01581-9973

b) TELEPHONE - Call TIPS at (508) 870—1600 for all orders that will be charged by credit card or paid for by purchase

orders over $50.00. Operators are available from 8:30 AM to 5:00 PM EST.

METHOD OF PAYMENT

2. Asacustomer, you have several payment options:

a) Purchase Order — Minimum of $50. If ordering by mail, a hard copy of the purchase order must accompany order.

b) Check or Money Order — Make payable to Data General Corporation.

c) Credit Card — A minimum order of $20 is required for Mastercard or Visa orders.

SHIPPING

3. To determine the charge for UPS shipping and handling, check the total quantity of units in your order and refer to the

following chart:

Total Quantity Shipping & Handling Charge

1-4 Units $5.00

5—10 Units $8.00

11-40 Units $10.00

41-200 Units $30.00

Over 200 Units $100.00

If overnight or second day shipment is desired, this information should be indicated on the order form. A separate charge

will be determined at time of shipment and added to your bill.

VOLUME DISCOUNTS

4. The TIPS discount schedule is based upon the total value of the order.

Order Amount Discount

$1-$149.99 0%

$150-$499.99 10%

Over $500 20%

TERMS AND CONDITIONS

5. Read the TIPS terms and conditions on the reverse side of the order form carefully. These must be adhered to at all times.

DELIVERY

6. Allow at least two weeks for delivery.

RETURNS

7. Items ordered through the TIPS catalog may not be returned for credit.

8. Order discrepancies must be reported within 15 days of shipment date. Contact your TIPS Administrator at (508) 870-1600

to notify the TIPS department of any problems.

INTERNATIONAL ORDERS

9. Customers outside of the United States must obtain documentation from their local Data General Subsidiary or

Representative. Any TIPS orders received by Data General U.S. Headquarters will be forwarded to the appropriate DG

Subsidiary or Representative for processing.





TIPS ORDER FORM
Mail To: | Data General Corporation

Attn: Educational Services/TIPS G155

4400 Computer Drive

Westboro, MA 01581 - 9973
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BILL: TG: “SHIP TO: (No BO. Boxes - Compista Oni

COMPANY NAME COMPANY NAM

ATTN: ATTN:

ADDRESS ADDRESS (NO PO BOXES)

CITY CITY

STATE ZIP | STATE Z\P

Priority Code (See label on back of catalog)

Authorized Signature of Buyer Title Date Phone (Area Code) Ext.

ere e a s teneO, bye 0 e828 one tHe ot 6 8 Oe ee ee sete
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COUNTQEEE. ORDER TOTAL

C) ups ADD Order Amount Save Less Discount _
1-4 Items $ 5.00 $0 — $149.99 0% See B

5-10 Items $ 8.00 $150 — $499.99 10% ra emp # SUB TOTAL
11-40 Items $ 10.00 Over $500.00 20% i applic able OO
41-200 Items $ 30.00 sales tax *

| __200+ Items $100.00 "Shipping and ;
Check for faster delivery _handling—See A

Aadlional charge toe determined st ie o TOTAL - See C
(J UPS Blue Label (2 day shipping)

(J Red Label (overnight shipping)

THANK YOU FOR YOUR ORDER

P.O. number is . (Include hardcopy P.O.) PRICES SUBJECT TO CHANGE WITHOUT PRIOR NOTICE.
[Check or Money Order Enclosed PLEASE ALLOW 2 WEEKS FOR DELIVERY.
C)Visa CJMasterCard ($20 minimum on credit cards)

Account Number Expiration Date * Data General is required by law to collect applicable sales or use tax on all
purchases shipped to states where DG maintains a place of business, which

‘| | | | | | | | | | i | | [TLE] covers all 50 states. Please include your local taxes when determining the total
value of your order. If you are uncertain about the correct tax amount, please call
508-870-1600.

Authorized Signature

(Credit card orders without signature and expiration date cannot be processed.)



Form 702

Rev. 8/87

DATA GENERAL CORPORATION

TECHNICAL INFORMATION AND PUBLICATIONS SERVIC!

TERMS AND CONDITIONS

Data General Corporation (“DGC”) provides its Technical Information and Publications Service (TIPS) solely in accordance with the following

terms and conditions and more specifically to the Customer signing the Educational Services TIPS Order Form. These terms and conditions

apply to all orders, telephone, telex, or mail. By accepting these products the Customer accepts and agrees to be bound by these terms and

conditions.

1. CUSTOMER CERTIFICATION

Customer hereby certifies that it is the owner or lessee of the DGC equipment and/or licensee/sub—licensee of the software which is the

subject matter of the publication(s) ordered hereunder.

2. TAXES

Customer shall be responsible for all taxes, including taxes paid or payable by DGC for products or services supplied under this Agreement,

exclusive of taxes based on DGC’s net income, unless Customer provides written proof of exemption.

3. DATA AND PROPRIETARY RIGHTS

Portions of the publications and materials supplied under this Agreement are proprietary and will be so marked. Customer shall abide by suc
markings. DGC retains for itself exclusively all proprietary rights (including manufacturing rights) in and to all designs, engineering details anc

other data pertaining to the products described in such publication. Licensed software materials are provided pursuant to the terms and

conditions of the Program License Agreement (PLA) between the Customer and DGC and such PLA is made a part of and incorporated into

this Agreement by reference. A copyright notice on any data by itself does not constitute or evidence a publication or public disclosure.

4. LIMITED MEDIA WARRANTY

DGC warrants the CLI Macros media, provided by DGC to the Customer under this Agreement, against physical defects for a period of ninet

(90) days from the date of shipment by DGC. DGC will replace defective media at no charge to you, provided it is returned postage prepaid t

DGC within the ninety (90) day warranty period. This shall be your exclusive remedy and DGC’s sole obligation and liability for defective mec

This limited media warranty does not apply if the media has been damaged by accident, abuse or misuse.

5. DISCLAIMER OF WARRANTY

EXCEPT FOR THE LIMITED MEDIA WARRANTY NOTED ABOVE, DGC MAKES NO WARRANTIES, EXPRESS OR IMPLIED,

INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE ON ANY Ol

THE PUBLICATIONS, CLI MACROS OR MATERIALS SUPPLIED HEREUNDER.

6. LIMITATION OF LIABILITY

A. CUSTOMER AGREES THAT DGC’S LIABILITY, IF ANY, FOR DAMAGES, INCLUDING BUT NOT LIMITED TO LIABILITY ARISING

OUT OF CONTRACT, NEGLIGENCE, STRICT LIABILITY IN TORT OR WARRANTY SHALL NOT EXCEED THE CHARGES PAID BY

CUSTOMER FOR THE PARTICULAR PUBLICATION OR CLI MACRO INVOLVED. THIS LIMITATION OF LIABILITY SHALL NOT APPLY

TO CLAIMS FOR PERSONAL INJURY CAUSED SOLELY BY DGC’S NEGLIGENCE. OTHER THAN THE CHARGES REFERENCED

HEREIN, IN NO EVENT SHALL DGC BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES

WHATSOEVER, INCLUDING BUT NOT LIMITED TO LOST PROFITS AND DAMAGES RESULTING FROM LOSS OF USE, OR LOST

DATA, OR DELIVERY DELAYS, EVEN IF DGC HAS BEEN ADVISED, KNEW OR SHOULD HAVE KNOWN OF THE POSSIBILITY

THEREOF; OR FOR ANY CLAIM BY ANY THIRD PARTY.

B. ANY ACTION AGAINST DGC MUST BE COMMENCED WITHIN ONE (1) YEAR AFTER THE CAUSE OF ACTION ACCRUES.

7. GENERAL

A valid contract binding upon DGC will come into being only at the time of DGC’s acceptance of the referenced Educational Services Order

Form. Such contract is governed by the laws of the Commonwealth of Massachusetts, excluding its conflict of law rules. Such contract is not

assignable. These terms and conditions constitute the entire agreement between the parties with respect to the subject matter hereof and

supersedes all prior oral or written communications, agreements and understandings. These terms and conditions shall prevail notwithstandi

any different, conflicting or additional terms and conditions which may appear on any order submitted by Customer. DGC hereby rejects all

such different, conflicting, or additional terms.

8. IMPORTANT NOTICE REGARDING AOS/VS INTERNALS SERIES (ORDER #1865 & #1875)

Customer understands that information and material presented in the AOS/VS Internals Series documents may be specific to a particular

revision of the product. Consequently user programs or systems based on this information and material may be revision—locked and may no!

function properly with prior or future revisions of the product. Therefore, Data General makes no representations as to the utility of this

information and material beyond the current revision level which is the subject of the manual. Any use thereof by you or your company is at

your own risk. Data General disclaims any liability arising from any such use and | and my company (Customer) hold Data General complete

harmless therefrom.
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